Gateway Network Communication Kits

Installation and program setup instructions for use with ProMix® 2KS Electronic Proportioners. For professional use only.

Not approved for use in European explosive atmosphere locations.

See page 3 for kit information.

Important Safety Instructions
Read all warnings and instructions in this manual and in your proportioning system manual. Save these instructions.
**Graco Gateway Kits**

**25B471 Gateway Ethernet Kit**  
Allows communication between ProMix 2KS and a PLC over an ethernet. Enables process equipment to read variables while operating, as well as control the ProMix 2KS and change setup. It does not provide access to job and alarm logs.

**25B472 Gateway DeviceNet Kit**  
Allows communication between ProMix 2KS and a PLC, using DeviceNet process control. Enables process equipment to read variables while operating, as well as control the ProMix 2KS and change setup. It does not provide access to job and alarm logs.

**25B473 Gateway Profibus Kit**  
Allows communication between ProMix 2KS and a PLC, using Profibus process control. Enables process equipment to read variables while operating, as well as control the ProMix 2KS and change setup. It does not provide access to job and alarm logs.

**Related Manuals**

<table>
<thead>
<tr>
<th>Manual</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>312778</td>
<td>ProMix 2KS Automatic System Installation</td>
</tr>
<tr>
<td>312779</td>
<td>ProMix 2KS Automatic System Operation</td>
</tr>
<tr>
<td>312780</td>
<td>ProMix 2KS Automatic System Repair-Parts</td>
</tr>
<tr>
<td>313386</td>
<td>Basic Web Interface/Advanced Web Interface</td>
</tr>
</tbody>
</table>
Warnings

The following warnings are for the setup, use, grounding, maintenance, and repair of this equipment. The exclamation point symbol alerts you to a general warning and the hazard symbols refer to procedure-specific risks. When these symbols appear in the body of this manual, refer back to these Warnings. Product-specific hazard symbols and warnings not covered in this section may appear throughout the body of this manual where applicable.

<table>
<thead>
<tr>
<th>![WARNING]</th>
<th>FIRE AND EXPLOSION HAZARD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flammable fumes, such as solvent and paint fumes, in work area can ignite or explode. To help prevent fire and explosion:</td>
<td></td>
</tr>
<tr>
<td>• Use equipment only in well ventilated area.</td>
<td></td>
</tr>
<tr>
<td>• Eliminate all ignition sources; such as pilot lights, cigarettes, portable electric lamps, and plastic drop cloths (potential static arc).</td>
<td></td>
</tr>
<tr>
<td>• Keep work area free of debris, including solvent, rags and gasoline.</td>
<td></td>
</tr>
<tr>
<td>• Do not plug or unplug power cords, or turn power or light switches on or off when flammable fumes are present.</td>
<td></td>
</tr>
<tr>
<td>• Ground all equipment in the work area. See Grounding instructions.</td>
<td></td>
</tr>
<tr>
<td>• Use only grounded hoses.</td>
<td></td>
</tr>
<tr>
<td>• Hold gun firmly to side of grounded pail when triggering into pail.</td>
<td></td>
</tr>
<tr>
<td>• If there is static sparking or you feel a shock, stop operation immediately. Do not use equipment until you identify and correct the problem.</td>
<td></td>
</tr>
<tr>
<td>• Keep a working fire extinguisher in the work area.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>![WARNING]</th>
<th>ELECTRIC SHOCK HAZARD</th>
</tr>
</thead>
<tbody>
<tr>
<td>This equipment must be grounded. Improper grounding, setup, or usage of the system can cause electric shock.</td>
<td></td>
</tr>
<tr>
<td>• Turn off and disconnect power at main switch before disconnecting any cables and before servicing equipment.</td>
<td></td>
</tr>
<tr>
<td>• Connect only to grounded power source.</td>
<td></td>
</tr>
<tr>
<td>• All electrical wiring must be done by a qualified electrician and comply with all local codes and regulations.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>![WARNING]</th>
<th>EQUIPMENT MISUSE HAZARD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Misuse can cause death or serious injury.</td>
<td></td>
</tr>
<tr>
<td>• Do not operate the unit when fatigued or under the influence of drugs or alcohol.</td>
<td></td>
</tr>
<tr>
<td>• Do not exceed the maximum working pressure or temperature rating of the lowest rated system component. See Technical Data in all equipment manuals.</td>
<td></td>
</tr>
<tr>
<td>• Use fluids and solvents that are compatible with equipment wetted parts. See Technical Data in all equipment manuals. Read fluid and solvent manufacturer’s warnings. For complete information about your material, request MSDS forms from distributor or retailer.</td>
<td></td>
</tr>
<tr>
<td>• Check equipment daily. Repair or replace worn or damaged parts immediately with genuine manufacturer’s replacement parts only.</td>
<td></td>
</tr>
<tr>
<td>• Do not alter or modify equipment.</td>
<td></td>
</tr>
<tr>
<td>• Use equipment only for its intended purpose. Call your distributor for information.</td>
<td></td>
</tr>
<tr>
<td>• Route hoses and cables away from traffic areas, sharp edges, moving parts, and hot surfaces.</td>
<td></td>
</tr>
<tr>
<td>• Do not kink or over bend hoses or use hoses to pull equipment.</td>
<td></td>
</tr>
<tr>
<td>• Keep children and animals away from work area.</td>
<td></td>
</tr>
<tr>
<td>• Comply with all applicable safety regulations.</td>
<td></td>
</tr>
</tbody>
</table>
Graco Gateway Overview

The Graco Gateway enables the ProMix 2KS to network with a programmable logic controller (PLC). Kits are available for Ethernet, DeviceNet, or Profibus protocols. The Graco Gateway will support many other protocols; contact Graco Technical Assistance for information to support your desired protocol.

**NOTE:** Only persons very familiar with their PLC communication architecture should use this hardware and software. This manual assumes that the person using the Graco Gateway has full understanding of the PLC equipment and related software.

**NOTE:** Network communications essentially operate with the same rules as Discrete I/O. However, network communications require placing correct values or adjusting appropriate bits within various Modbus registers (for example, see Table 4). These changes should only be made by qualified persons familiar with this type of communication.

The module allows for most PLCs to communicate with the ProMix 2KS via Modbus RTU protocol by bridging the gap between the desired communication protocol and RS485 Modbus RTU. As a result, the PLC has full access to all the registers for monitoring and controlling the ProMix 2KS. It is the responsibility of the integrator or user to ensure proper configuration of the communication hardware on the PLC side.

Install the Gateway Module Hardware

**Location**

This equipment is not for use in explosive atmospheres. Do not install equipment approved only for non-hazardous location in a hazardous area.

Install the Gateway module near the EasyKey™, in a non-hazardous area.

**Mounting**

1. See **Dimensions**, page 84.

2. Ensure that the wall and mounting hardware are strong enough to support the weight of the equipment, cables, and stress caused during operation.

3. Using the equipment as a template, mark the mounting holes on the wall at a convenient height for the operator and so equipment is easily accessible for maintenance.

4. Drill mounting holes in the wall. Install anchors as needed.

5. Bolt equipment securely.

**Grounding**

Your system must be grounded. Read **Warnings**, page 4.

The Gateway module is grounded through its connection to the EasyKey, which must be connected to a true earth ground. See the system installation manual. A ground wire and clamp, part no. 223547, is available from Graco.
Fig. 1: Graco Gateway Typical Installation
Connect the Module to the EasyKey

1. Shut off ProMix 2KS power (0 position). Fig. 2. Also shut off power at main circuit breaker.

2. Connect a 2-wire twisted pair cable with shield wire from the EasyKey connector to the connector on the Gateway module. Connect a communications wire/cable (protocol dependent) from the Gateway module to the PLC. See Fig. 4.

**NOTE:** Graco provides expansion cards for DeviceNet and Proibus protocols. DeviceNet setup procedures are on page 47. Proibus setup procedures are on page 62. See page 44 for Parts.

**NOTE:** If using the Graco Gateway in your system, disconnect its cable from the EasyKey before updating the ProMix 2KS software.

---

Fig. 2: Power Off

---

![Power Off](image)
1. Shut off ProMix 2KS power (0 position). Fig. 2. Also shut off power at main circuit breaker.

2. Connect the line (L) and neutral (N) wires from a 100-240V, 45-65 Hz, AC power source to the 24V power supply as shown.

3. Use the two lengths of 16 AWG wire (26 and 28, provided) to connect the power supply (10) to the gateway (14), as shown.

4. Connect the desired communication cables (see Cabling Connections, pages 9-11).

5. After all connections have been made, connect power to the 100-240V AC source.
Cabling Connections

See Fig. 5 and Fig. 6 for typical cable connections in a ProMix 2KS system.

Fig. 7 through Fig. 10 show other possible cable connections.

**EasyKey (Bottom View)**

2-wire twisted pair cable, with shield wire (to Gateway Module)

**Gateway Module**

Communication Wire/Cable (to PLC). This connection is protocol dependent.

2-wire twisted pair cable, with shield wire (to EasyKey).

See **Wiring Diagrams** on page 45 for pin connections.

**Fig. 4: EasyKey and Module Cable Connection Points**
Install the Gateway Module Hardware

Fig. 5: Graco Gateway Port Pin Outs

Fig. 6: RS485 Communication Port (Typical ProMix 2KS Connection)
**Fig. 7: Programming Ports**

**Fig. 8: RS232/PG Communication Ports**

**Fig. 9: RS232 Communication Ports**
Install the Gateway Module Hardware

Mount the Control on DIN Rail

The Gateway control mounts on a DIN rail. Tilt the control and push down onto the DIN rail, then push in. See Fig. 11. A minimum clearance of 1 in. (25 mm) above and below the control is required to ensure adequate ventilation.

Install CompactFlash® Card

The CompactFlash socket accepts either Type I or Type II cards. These cards are available at most computer and office supply retailers. Use cards with a minimum of 4 Mbytes and a maximum of 2 Gbytes. Use the CompactFlash card for optional database storage only. See Fig. 12.

---

Fig. 10: Ethernet Connection

Fig. 11: Mount the Control on a DIN Rail

Fig. 12: Install a CompactFlash Card
Install the GracoConfig Software

GracoConfig software provides access to the Graco Gateway module hardware. The CD provided contains the GracoConfig software (GracoConfigXXX.exe, where the XXX represents the version control number). It also includes a preconfigured database which is essentially a setup file for the Gateway. The database file has a .gg2 extension.

The Graco Gateway provides conversions for many protocols, including the following:

- All Allen-Bradley protocols
- DeviceNet
- Ethernet TCP/IP
- Ethernet IP
- Mitsubishi
- Modbus (ASCII, RTU)
- Profibus
- Siemens

**NOTE:** Graco provides expansion cards for DeviceNet and Profibus protocols. DeviceNet setup procedures are on page 47. Profibus setup procedures are on page 62. See page 44 for Parts.

**NOTE:** Contact your Graco distributor or Graco Technical Assistance for information regarding additional supported protocols.

System Requirements

GracoConfig software will run on PCs with the following specifications:

- A Pentium class processor as required by the chosen operating system.

**NOTE:** GracoConfig software will operate with all versions of Microsoft® Windows 98 and above. Windows 2000 or above is recommended for more robust operation.

- RAM and free disk space as required by the chosen operating system.

- An additional 50MB of disk space for software installation.

- A display of at least 800 by 600 pixels, with 256 or more colors.

- USB port for downloading a configured database to the Gateway module.
Install the GracoConfig Software

Load the Software

1. Connect the USB cable (34, supplied) between the USB port on the Gateway module and a USB port on your PC. See Fig. 13.

2. Fig. 14 will appear. Select “Yes, this time only”, then click Next.

3. Fig. 15 will appear. Insert the CD in your PC’s CDROM drive. Select “Install the software from a list or specific location”, then click Next. The program location is C:\Program Files\Graco\GracoConfig\Device.

   NOTE: The name of the driver may be different. Just accept the name and proceed by following the instructions on the screen.

Software Updates

Contact your distributor or Graco Technical Assistance for software updates.
Download the Preconfigured Database to the Gateway Module

Graco supplies a preconfigured database as a setup file for the Gateway, containing parameters which communicate between the Gateway and the ProMix 2KS. The file name has a .gg2 extension.

GracoConfig files are downloaded to the Gateway module using the Link menu. The programming link between the PC and the Gateway module uses the USB cable. Before downloading, check that the Communications Port is set to USB, as follows.

NOTE: During programming the Gateway module may ask for an updated driver. Follow the instructions on the screen to automatically find and select the drivers.

1. Go to Start>Programs>Graco>GracoConfig and run the program. The GracoConfig main page will appear.

2. Using the Link pulldown menu, select Options to open the Link Options window. Check that the Communications Port is set to USB, and click OK.

3. Go to File>Open and select the file with the xx.gg2 extension. The file name should appear at the top of the window (FIG. 16) once loaded.

4. Download the database using the Link>Update command. As a shortcut, use the Update symbol on the toolbar. See FIG. 16.

NOTE: Downloading typically takes only a few seconds but may take longer if the software has to update firmware on the Gateway module.
Graco Gateway Network Communications Configuration

Startup

To run GracoConfig, select the icon from the Graco folder on the Programs section of your Start Menu. The main page will appear, showing the Communications button.

GracoConfig Main Page

Communications Button

The Communications button provides access to screens used to configure your system and setup parameters, allowing you to:

- Specify which protocols are to be used on the Gateway serial ports and on the Ethernet port.
- If using master protocols (i.e., protocols by which the Gateway initiates data transfer to and from a remote device), you can specify one or more devices to be accessed.
- If using slave protocols (i.e., protocols by which the Gateway receives and responds to requests from remote devices or computer systems), you can set read or write access for specific data items.
- Move data between one remote device and another.

Balloon Help

The Balloon Help feature allows you to see help information for each icon in the main menu, or for each field in a dialog box or window. It is controlled via the icon at the right-hand edge of the toolbar. Balloon Help has three user-selectable modes:

- **Do Not Display** disables balloon help
- **When Mouse Over** displays help when the mouse pointer is held over a particular field for a certain period of time
- **When Selected** displays help constantly for the currently selected field.
Setup the Database

1. Double-click on the Communications button to open the preconfigured database (.gg2). The file is already setup for ProMix 2KS. See Fig. 19.

   ![Preconfigured Database](image1)

   **Fig. 19: Preconfigured Database**

2. See Fig. 20. Highlight Protocol 1. Click the Edit button on the right side of the window to open the Driver Picker window. Choose a protocol from the lists provided, in this example Modbus and TCP/IP Slave. The system will create device PLC1.

   ![Select Protocol](image2)

   **Fig. 20: Select Protocol**
3. See Fig. 21. Right click on device PLC1 to rename it to something meaningful for your system.

**Fig. 21: Rename PLC1**

4. See Fig. 22. Add as many Gateway blocks as desired under each device.

**Fig. 22: Add Gateway Blocks**
Map Data

1. See Fig. 23. Select the block for data mapping. Click the Edit button next to the Start Address field on the right side of the window. The Select Address window will open.

2. Refer to Table 4 on page 31 for a Modbus map. Select the desired Modbus register address as a starting point (in this case 40002). Enter the appropriate values in the Select Address window and click OK. The desired register address will populate the Start Address field.

Fig. 23: Mapping Gateway Blocks
3. See Fig. 24. Click the Edit button next to the Block Size field on the right side of the window. The Edit Value window will open. Enter the number of Modbus register addresses in the range from the starting address entered in step 2 to the desired ending address, inclusive. In this example, 7. The addresses must be contiguous. This means that each address must be available and addressable from the ProMix 2KS. If one of the 7 addresses does not exist within the ProMix 2KS Modbus structure, the complete block will not communicate.

**Fig. 24: Setting Block Size**
4. See Fig. 25. Click OK. The range of addresses will appear under the appropriate Block on the left side of the window.

NOTE: In this example, a Modbus device master communicating via TCP/IP will have direct access to Modbus registers 40002 through 40008 of the ProMix 2KS. For example, see Block 1 address line 1:

```
<table>
<thead>
<tr>
<th>Block</th>
<th>Modbus address (command) from TCP/IP master connected to Modbus address of ProMix 2KS.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block 1</td>
<td>400002 &lt;-&gt; ProMix2KS.400002</td>
</tr>
</tbody>
</table>
```

5. The Direction field typically should remain set to Device to G3.

Fig. 25: Block Mapping Data
Modbus and I/O Data

See Table 4 through Table 5 for Modbus register addresses and input/output data.

Reference the Discrete I/O listing of all the inputs and outputs (see page 31). Ensure these are fully understood. The same implementation used for Discrete I/O is used for the Network communication protocol.

For example: The Gun Trigger Input will now be a specific bit of Modbus Register 40040. Monitoring of Modbus Register 40041 for specific output status conditions will be required as explained in the Discrete I/O section of the ProMix 2KS Operation manual. The PLC will have to read the various bits, and in some cases (40040 and 40041 for example) must mask out the various bit positions to determine each of the separate input and output statuses. This requires experience and should not be done on the job site. A full understanding of the color change process as well as the required timing of various inputs and outputs is required.

NOTE: Analog input for flow control set point will now be a dedicated Modbus register. Register 40137 will require the specific flow rate (i.e. 125 cc/min). This is not a voltage reading but the actual flow target.

Start Mix Process

See Fig. 26, Table 1, and Table 2.

1. Verify that the Mix Ready bit (bit 2 of 40041) is on.
2. Turn on the Mix bit (bit 7 of 40040).
3. Verify that the Mix Active bit (bit 1 of 40041) is on, to ensure that the Mix request was received.

Stop Mix Process

See Fig. 27, Table 1, and Table 2.

1. Clear the Mix bit.

2. The Mix Active output should clear and Mix Ready should now be set.

NOTE: The ProMix 2KS will automatically go into Idle mode after 2 minutes of inactivity. A general alarm will be present and Mix Active will remain High. The Alarm bit (40010) will indicate the system Idle alarm. When a new Gun Trigger input is seen, the ProMix 2KS will resume mixing material where it left off. Do not toggle the Mix bit; doing so restarts the Mix process from the beginning.

Color Change Process

See Fig. 29, Table 1, and Table 2.

1. Verify that Mix Ready is set. This ensures that there are no alarms and that the system is ready for the next command.
2. Load ccNewRecipe (Modbus 40046) with a recipe number to color change to.
3. Set color change (40040 bit 6).
4. Verify that Purge_CC_Active is seen (40041 bit 0).
5. Clear color change bit (momentary only).
6. Do not change the ccNewRecipe value until a new recipe change is requested.
7. The color change process will stop automatically as programmed. Monitor Purge_CC_Active bit for completion.

Purge Process

See Fig. 28, Table 1, and Table 2.

1. Verify that Mix Ready is set. This ensures that there are no alarms and that the system is ready for the next command.
2. Set purge (40040 bit 8).
3. Verify that Purge_CC_Active is seen (40041 bit 0).
4. When Purge_CC_Active bit clears, clear Purge_Start bit. Clearing this bit in the middle of a purge sequence will abort the purge sequence.
NOTE: At power up the system defaults to Recipe 61, which is not a valid recipe number. Initiate a color change to Recipe 0 or a valid recipe number (1-60).

**Fig. 26. Start Mix Mode Process Flow Chart**
Mixing Mode Process

Mixing Mode is desired. PLC is polling to ensure Mixing Mode is maintained.

Is Mix Active bit = 1?

NO

Check Alarm Condition: is Alarm General bit = 1?

NO

2KS is in Standby. Go to Start Mix Process, page 22.

YES

YES

Mixing Process active

Go to Alarm Processing, page 27

Fig. 27. Mixing Mode Process Flow Chart
**NOTE**: At power up the system defaults to Recipe 61, which is not a valid recipe number. Initiate a color change to Recipe 0 or a valid recipe number (1-60).

**Fig. 28. Purge Mode Process Flow Chart**
FIG. 29. Color Change Mode Process Flow Chart

- **Color Change Process (basic)**
  - **Is Active Recipe = to desired recipe? (Register 40005).**
    - **YES**
      - Check Alarm Condition: is Alarm_General bit = 1?
        - **NO**
          - Do nothing. Spraying at desired recipe.
        - **YES**
          - Is Mix Ready bit = 1?
            - **NO**
              - Load ccNewRecipe (Register 40046) with recipe number to Color Change to (0 through 60 is valid).
            - **YES**
              - Set ColorChange (CC) bit = 1.
    - **NO**
      - Ensure ColorChange bit is seen by ProMix

- **ProMix 2KS Color Change Process (Complete)**
  - **Is Mix Ready bit = 1?**
    - **NO**
      - (Wait for Mix Ready)
    - **YES**
      - ProMix 2KS Color Change Process (Complete)
  - **Check Alarm Condition: is Alarm_General bit = 1?**
    - **NO**
      - Process Alarm. See *Alarm Processing*, page 27.
    - **YES**
      - Clear ColorChange (CC) bit (momentary input). CC process started.
Alarm Processing

See Fig. 30, Table 1, Table 2, and Table 3.

**Fig. 30. Alarm Processing Flow Chart**
### Table 1: ProMix 2KS Digital Inputs (Modbus Register 40040)

<table>
<thead>
<tr>
<th>Bit</th>
<th>Digital Input Binary</th>
<th>Name</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>0:5</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 X X X X X</td>
<td>Recipe</td>
<td>Binary bits for viewing discrete inputs only.</td>
</tr>
<tr>
<td>6</td>
<td>0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0</td>
<td>Color Change (CC)</td>
<td>Set bit to “1” to initiate Color Change (momentary)</td>
</tr>
<tr>
<td>7</td>
<td>0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0</td>
<td>Mix</td>
<td>Set bit initiate Mix mode (maintain)</td>
</tr>
<tr>
<td>8</td>
<td>0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0</td>
<td>Purge</td>
<td>Set bit to “1” to initiate Purge sequence (maintained)</td>
</tr>
<tr>
<td>9</td>
<td>0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0</td>
<td>Job_Complete</td>
<td>Set bit to “1” to initiate Job Complete input (momentary)</td>
</tr>
<tr>
<td>10</td>
<td>0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0</td>
<td>External CC Ready</td>
<td>Set bit to “1” to initiate External Color Change (momentary)</td>
</tr>
<tr>
<td>11</td>
<td>0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0</td>
<td>Not Used</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
<td>FC _Calibrate</td>
<td>Set bit to “1” to initiate a Flow Control Calibrate input (momentary)</td>
</tr>
<tr>
<td>13</td>
<td>0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
<td>Gun_Trigger</td>
<td>Set bit to “1” to indicate the gun is actually triggered (maintain while gun is triggered, remove when gun is closed)</td>
</tr>
<tr>
<td>14</td>
<td>0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
<td>Reset_Alarm</td>
<td>Set bit to “1” to clear an active Alarm (momentary)</td>
</tr>
<tr>
<td>15</td>
<td>1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
<td>Remote Stop</td>
<td>Set bit to remotely stop unit (momentary)</td>
</tr>
</tbody>
</table>

**NOTE:** Shaded cells relate to the flow charts on pages 24-27.
### Table 2: ProMix 2KS Digital Outputs (Modbus Register 40041)

<table>
<thead>
<tr>
<th>Bit</th>
<th>Digital Input Binary</th>
<th>Name</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0</td>
<td>Purge_CC_Active</td>
<td>“1” indicates Purge or Color Change is in progress</td>
</tr>
<tr>
<td>1</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1</td>
<td>Mix_Active</td>
<td>“1” indicates Mix is in progress</td>
</tr>
<tr>
<td>2</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0</td>
<td>Mix_Ready</td>
<td>“1” indicates No Alarms and OK to Mix</td>
</tr>
<tr>
<td>3</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0</td>
<td>CC_Fill_Active</td>
<td>“1” indicates the Fill portion of a Color Change is in progress</td>
</tr>
<tr>
<td>4</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1</td>
<td>FCaActive</td>
<td>“1” indicates the Flow Control Calibrate routine is in progress</td>
</tr>
<tr>
<td>5</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
<td>Flow_Rate_Alarm</td>
<td>“1” indicates the Flow Rate Alarm/Warning is active</td>
</tr>
<tr>
<td>6</td>
<td>0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0</td>
<td>Special_1</td>
<td>“1” indicates the Special_1 output is on (monitor only)</td>
</tr>
<tr>
<td>7</td>
<td>0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0</td>
<td>Special_2</td>
<td>“1” indicates the Special_2 output is on (monitor only)</td>
</tr>
<tr>
<td>8</td>
<td>0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0</td>
<td>Special_3</td>
<td>“1” indicates the Special_3 output is on (monitor only)</td>
</tr>
<tr>
<td>9</td>
<td>0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0</td>
<td>Special_4</td>
<td>“1” indicates the Special_4 output is on (monitor only)</td>
</tr>
<tr>
<td>10</td>
<td>0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0</td>
<td>Not Used</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0</td>
<td>Not Used</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
<td>Alarm_General</td>
<td>“1” indicates a General Alarm is in process. (If Mix_Active is still High, then a Warning only.) See ProMix 2KS Active Alarms (Modbus Register 40010) on page 30 for details on type.</td>
</tr>
<tr>
<td>13</td>
<td>0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
<td>Alarm_Potlife</td>
<td>“1” indicates a Potlife Alarm is in process.</td>
</tr>
</tbody>
</table>

**NOTE:** Shaded cells relate to the flow charts on pages 24-27.
# ProMix 2KS Active Alarms (Modbus Register 40010)

<table>
<thead>
<tr>
<th>Bit</th>
<th>Digital Input Binary</th>
<th>Name</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Byte: 0</td>
<td>0000 0000 0000 0000</td>
<td>No Bits Set</td>
<td>No Active Alarms</td>
</tr>
<tr>
<td>Low Byte: 0</td>
<td>0000 0000 0000 0001</td>
<td>Comm_Error</td>
<td></td>
</tr>
<tr>
<td>Low Byte: 0</td>
<td>0000 0000 0000 0010</td>
<td>Potlife_Alarm</td>
<td></td>
</tr>
<tr>
<td>Low Byte: 0</td>
<td>0000 0000 0000 0100</td>
<td>Ratio_High_Alarm</td>
<td></td>
</tr>
<tr>
<td>Low Byte: 0</td>
<td>0000 0000 0000 1000</td>
<td>Ratio_Low_Alarm</td>
<td></td>
</tr>
<tr>
<td>Low Byte: 0</td>
<td>0000 0000 0001 0000</td>
<td>Overdose_A_Alarm</td>
<td></td>
</tr>
<tr>
<td>Low Byte: 0</td>
<td>0000 0000 0010 0000</td>
<td>Overdose_B_Alarm</td>
<td></td>
</tr>
<tr>
<td>Low Byte: 0</td>
<td>0000 0000 0100 0000</td>
<td>Dose_Time_A_Alarm</td>
<td></td>
</tr>
<tr>
<td>Low Byte: 0</td>
<td>0000 0000 1000 0000</td>
<td>Dose_Time_B_Alarm</td>
<td></td>
</tr>
<tr>
<td>Low Byte: 0</td>
<td>0000 0001 0000 0000</td>
<td>Mix_In_Setup_Alarm</td>
<td></td>
</tr>
<tr>
<td>Low Byte: 0</td>
<td>0000 0010 0000 0000</td>
<td>Remote_Stop_Alarm</td>
<td></td>
</tr>
<tr>
<td>Low Byte: 0</td>
<td>0000 0100 0000 0000</td>
<td>Purge_Volume_Alarm</td>
<td></td>
</tr>
<tr>
<td>Low Byte: 0</td>
<td>0000 1000 0000 0000</td>
<td>CC_Comm_Error_Alarm</td>
<td></td>
</tr>
<tr>
<td>Low Byte: 0</td>
<td>0001 0000 0000 0000</td>
<td>High_Flow_Alarm</td>
<td></td>
</tr>
<tr>
<td>Low Byte: 0</td>
<td>0010 0000 0000 0000</td>
<td>Low_Flow_Alarm</td>
<td></td>
</tr>
<tr>
<td>Low Byte: 0</td>
<td>0100 0000 0000 0000</td>
<td>System_Idle_Alarm</td>
<td></td>
</tr>
<tr>
<td>Low Byte: 0</td>
<td>1000 0000 0000 0000</td>
<td>Setup_Change_Alarm</td>
<td></td>
</tr>
<tr>
<td>High Byte: 0</td>
<td>0000 0000 0000 0001</td>
<td>Power_On_Alarm</td>
<td></td>
</tr>
<tr>
<td>High Byte: 0</td>
<td>0000 0000 0000 0010</td>
<td>Defaults_Loaded_Alarm</td>
<td></td>
</tr>
<tr>
<td>High Byte: 0</td>
<td>0000 0000 0000 0100</td>
<td>IO_Alarm</td>
<td></td>
</tr>
<tr>
<td>High Byte: 0</td>
<td>0000 0000 0000 1000</td>
<td>Purge_Initiate_Error</td>
<td></td>
</tr>
<tr>
<td>High Byte: 0</td>
<td>0000 0000 0001 0000</td>
<td>Material_Fill_Alarm</td>
<td></td>
</tr>
<tr>
<td>High Byte: 0</td>
<td>0000 0000 0010 0000</td>
<td>Tank_A_Low_Alarm</td>
<td></td>
</tr>
<tr>
<td>High Byte: 0</td>
<td>0000 0000 0100 0000</td>
<td>Tank_B_Low_Alarm</td>
<td></td>
</tr>
<tr>
<td>High Byte: 0</td>
<td>0000 0000 1000 0000</td>
<td>Tank_S_Low_Alarm</td>
<td></td>
</tr>
<tr>
<td>High Byte: 0</td>
<td>0000 0001 0000 0000</td>
<td>Auto_Dump_Complete</td>
<td></td>
</tr>
<tr>
<td>High Byte: 0</td>
<td>0000 0010 0000 0000</td>
<td>Color/Catalyst_Purge_Alarm</td>
<td></td>
</tr>
<tr>
<td>High Byte: 0</td>
<td>0000 0100 0000 0000</td>
<td>Color/Catalyst_Fill_Alarm</td>
<td></td>
</tr>
<tr>
<td>High Byte: 0</td>
<td>0000 1000 0000 0000</td>
<td>Num_Alarm_Desc</td>
<td></td>
</tr>
<tr>
<td>High Byte: 0</td>
<td>0001 0000 0000 0000</td>
<td>Spare3_Alarm</td>
<td></td>
</tr>
<tr>
<td>High Byte: 0</td>
<td>0010 0000 0000 0000</td>
<td>Spare2_Alarm</td>
<td></td>
</tr>
<tr>
<td>High Byte: 0</td>
<td>0100 0000 0000 0000</td>
<td>Spare1_Alarm</td>
<td></td>
</tr>
<tr>
<td>High Byte: 0</td>
<td>1000 0000 0000 0000</td>
<td>Potlife_Buzzer</td>
<td></td>
</tr>
</tbody>
</table>
# ProMix 2KS Modbus/TCP Variable Map

Table 4: ProMix 2KS Modbus/TCP Variable Map

<table>
<thead>
<tr>
<th>* Read/Write Status</th>
<th>EasyKey Modbus Register</th>
<th>Description</th>
<th>Size</th>
<th>Units</th>
<th>Low Limit</th>
<th>High Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>40003</td>
<td>Current flow rate</td>
<td>16 Bit</td>
<td>cc/min</td>
<td>0</td>
<td>5000</td>
</tr>
<tr>
<td>Read Only</td>
<td>40004</td>
<td>Actual ratio</td>
<td>16 Bit</td>
<td>none</td>
<td>0</td>
<td>9999</td>
</tr>
<tr>
<td>Read Only</td>
<td>40005</td>
<td>Active recipe</td>
<td>16 Bit</td>
<td>none</td>
<td>0</td>
<td>60</td>
</tr>
<tr>
<td>Read Only</td>
<td>40006</td>
<td>Potlife 1 remaining</td>
<td>16 Bit</td>
<td>sec</td>
<td>0</td>
<td>9999</td>
</tr>
<tr>
<td>Read/Write</td>
<td>40007</td>
<td>Job complete</td>
<td>16 Bit</td>
<td>none</td>
<td>0</td>
<td>0xFFFF</td>
</tr>
<tr>
<td>Read/Write</td>
<td>40008</td>
<td>Reset job total</td>
<td>16 Bit</td>
<td>none</td>
<td>0</td>
<td>9</td>
</tr>
<tr>
<td>Read Only</td>
<td>40009</td>
<td>Potlife 2 remaining</td>
<td>16 Bit</td>
<td>sec</td>
<td>0</td>
<td>9999</td>
</tr>
<tr>
<td>Read Only</td>
<td>40010</td>
<td>Active fault</td>
<td>32 Bit</td>
<td>none</td>
<td>0</td>
<td>0xFFFFFFFF</td>
</tr>
<tr>
<td>Read Only</td>
<td>40032</td>
<td>Control version</td>
<td>32 Bit</td>
<td>none</td>
<td>0</td>
<td>0xFFFFFFFF</td>
</tr>
<tr>
<td>Read/Write</td>
<td>40040</td>
<td>Robot digital input</td>
<td>16 Bit</td>
<td>none</td>
<td>0x0000</td>
<td>0xFFFF</td>
</tr>
<tr>
<td>Read Only</td>
<td>40041</td>
<td>Robot digital output</td>
<td>16 Bit</td>
<td>none</td>
<td>0x0000</td>
<td>0xFFFF</td>
</tr>
<tr>
<td>Read/Write</td>
<td>40046</td>
<td>New recipe</td>
<td>16 Bit</td>
<td>none</td>
<td>0</td>
<td>60</td>
</tr>
<tr>
<td>Read Only</td>
<td>40048</td>
<td>Current fluid pressure</td>
<td>16 Bit</td>
<td>psi</td>
<td>0</td>
<td>5000</td>
</tr>
<tr>
<td>Read Only</td>
<td>40049</td>
<td>V/P percent output</td>
<td>16 Bit</td>
<td>%</td>
<td>0</td>
<td>100</td>
</tr>
<tr>
<td>Read Only</td>
<td><strong>40056</strong></td>
<td>Actual ratio reducer</td>
<td>16 Bit</td>
<td>none</td>
<td>0</td>
<td>9999</td>
</tr>
<tr>
<td>Read Only</td>
<td>40114</td>
<td>Flow control option</td>
<td>16 Bit</td>
<td>%</td>
<td>0=proportioning only 1=1K flow control (future) 2=2K flow control 3=pressure override 4=manual percent override</td>
<td>0</td>
</tr>
<tr>
<td>Read/Write</td>
<td>40115</td>
<td>Flow setpoint data source</td>
<td>16 Bit</td>
<td>none</td>
<td>0=discrete 1=network</td>
<td>0</td>
</tr>
<tr>
<td>Read/Write</td>
<td>40120</td>
<td>Manual override percent opening</td>
<td>16 Bit</td>
<td>%</td>
<td>0</td>
<td>100</td>
</tr>
<tr>
<td>Read/Write</td>
<td>40125</td>
<td>Flow control range</td>
<td>16 Bit</td>
<td>%</td>
<td>0=0-300 cc/min 1=0-600 cc/min 2=0-1200 cc/min</td>
<td>0</td>
</tr>
<tr>
<td>Read/Write</td>
<td>40126</td>
<td>Flow control tolerance</td>
<td>16 Bit</td>
<td>default=400</td>
<td>0 99</td>
<td></td>
</tr>
<tr>
<td>Read/Write</td>
<td>40127</td>
<td>Flow control proportional gain Kp</td>
<td>16 Bit</td>
<td>default=400</td>
<td>0 9999</td>
<td></td>
</tr>
<tr>
<td>Read/Write</td>
<td>40128</td>
<td>Flow control integral gain Ki</td>
<td>16 Bit</td>
<td>default=40</td>
<td>0 9999</td>
<td></td>
</tr>
<tr>
<td>Read/Write</td>
<td>40129</td>
<td>Flow control alarm time</td>
<td>16 Bit</td>
<td>sec</td>
<td>0</td>
<td>99</td>
</tr>
<tr>
<td>Read/Write</td>
<td>40137</td>
<td>Flow control setpoint</td>
<td>16 Bit</td>
<td>cc/min</td>
<td>0</td>
<td>1200</td>
</tr>
<tr>
<td>Read/Write</td>
<td>43123</td>
<td>Flow control override mode</td>
<td>16 Bit</td>
<td>0=off (normal) 1=% open 2=pressure mode</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>Read/Write</td>
<td>43141</td>
<td>Flow control enable</td>
<td>16 Bit</td>
<td>0=off 1=on</td>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>

* This column represents the rule that must be implemented by automation. Writing to Read Only registers must be avoided.

** For ProMix 3KS Systems only.
# ProMix 2KS Recipe Bits

## Table 5: ProMix 2KS Recipe Bits

<table>
<thead>
<tr>
<th>Recipe Bits</th>
<th>Number</th>
<th>Recipe Bits</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 0 0 0 0 0</td>
<td>0</td>
<td>1 0 0 0 0 1</td>
<td>33</td>
</tr>
<tr>
<td>0 0 0 0 0 1</td>
<td>1</td>
<td>1 0 0 0 1 0</td>
<td>34</td>
</tr>
<tr>
<td>0 0 0 0 1 0</td>
<td>2</td>
<td>1 0 0 1 0 0</td>
<td>35</td>
</tr>
<tr>
<td>0 0 0 1 1 0</td>
<td>3</td>
<td>1 0 1 0 0 0</td>
<td>36</td>
</tr>
<tr>
<td>0 0 1 0 0 0</td>
<td>4</td>
<td>1 0 1 0 1 0</td>
<td>37</td>
</tr>
<tr>
<td>0 0 1 0 1 0</td>
<td>5</td>
<td>1 0 1 1 0 0</td>
<td>38</td>
</tr>
<tr>
<td>0 0 1 1 0 0</td>
<td>6</td>
<td>1 0 1 1 0 1</td>
<td>39</td>
</tr>
<tr>
<td>0 0 1 1 1 0</td>
<td>7</td>
<td>1 0 1 0 0 0</td>
<td>40</td>
</tr>
<tr>
<td>0 1 0 0 0 0</td>
<td>8</td>
<td>1 0 1 0 1 0</td>
<td>41</td>
</tr>
<tr>
<td>0 1 0 0 0 1</td>
<td>9</td>
<td>1 0 1 0 1 1</td>
<td>42</td>
</tr>
<tr>
<td>0 1 0 0 1 0</td>
<td>10</td>
<td>1 0 1 1 0 0</td>
<td>43</td>
</tr>
<tr>
<td>0 1 0 1 0 0</td>
<td>11</td>
<td>1 0 1 0 1 0</td>
<td>44</td>
</tr>
<tr>
<td>0 1 0 1 0 1</td>
<td>12</td>
<td>1 0 1 0 1 1</td>
<td>45</td>
</tr>
<tr>
<td>0 1 0 1 1 0</td>
<td>13</td>
<td>1 0 1 1 0 0</td>
<td>46</td>
</tr>
<tr>
<td>0 1 0 1 1 1</td>
<td>14</td>
<td>1 0 1 1 1 1</td>
<td>47</td>
</tr>
<tr>
<td>0 1 1 0 0 0</td>
<td>15</td>
<td>1 1 0 0 0 0</td>
<td>48</td>
</tr>
<tr>
<td>0 1 1 0 0 1</td>
<td>16</td>
<td>1 1 0 0 1 0</td>
<td>49</td>
</tr>
<tr>
<td>0 1 1 0 1 0</td>
<td>17</td>
<td>1 1 0 0 1 1</td>
<td>50</td>
</tr>
<tr>
<td>0 1 1 0 1 1</td>
<td>18</td>
<td>1 1 0 1 0 0</td>
<td>51</td>
</tr>
<tr>
<td>0 1 1 1 0 0</td>
<td>19</td>
<td>1 1 0 1 0 1</td>
<td>52</td>
</tr>
<tr>
<td>0 1 1 1 0 1</td>
<td>20</td>
<td>1 1 0 1 1 0</td>
<td>53</td>
</tr>
<tr>
<td>0 1 1 1 1 0</td>
<td>21</td>
<td>1 1 0 1 1 1</td>
<td>54</td>
</tr>
<tr>
<td>0 1 1 1 1 1</td>
<td>22</td>
<td>1 1 0 0 0 0</td>
<td>55</td>
</tr>
<tr>
<td>1 0 0 0 0 0</td>
<td>23</td>
<td>1 1 0 0 1 0</td>
<td>56</td>
</tr>
<tr>
<td>1 0 0 0 0 1</td>
<td>24</td>
<td>1 1 0 0 1 1</td>
<td>57</td>
</tr>
<tr>
<td>1 0 0 1 0 0</td>
<td>25</td>
<td>1 1 1 0 0 1</td>
<td>58</td>
</tr>
<tr>
<td>1 0 0 1 0 1</td>
<td>26</td>
<td>1 1 1 0 1 1</td>
<td>59</td>
</tr>
<tr>
<td>1 0 0 1 1 0</td>
<td>27</td>
<td>1 1 1 1 0 0</td>
<td>60</td>
</tr>
<tr>
<td>1 0 1 1 0 0</td>
<td>28</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 0 1 1 0 1</td>
<td>29</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 0 1 1 1 0</td>
<td>30</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 0 1 1 1 1</td>
<td>31</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 0 0 0 0 0</td>
<td>32</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Troubleshooting

**NOTE:** This section covers the most common problems encountered while setting up, programming or using the product. Do not forget to always download in the device after changing settings in Graco Gateway.

## General Troubleshooting

<table>
<thead>
<tr>
<th>PROBLEM</th>
<th>CAUSE</th>
<th>SOLUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit screen is blank and PWR LED is off.</td>
<td>No power applied to the unit.</td>
<td>Check power supply. Units require 24 VDC, ± 10%.</td>
</tr>
<tr>
<td>Unit screen is blank and PWR LED is on.</td>
<td>Contrast too low (Graco Gateway only).</td>
<td>Program one of the soft keys with the action as User Defined and the fol-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>lowing code in the field On Pressed: dispcontrast++</td>
</tr>
<tr>
<td></td>
<td>No primitives on the display.</td>
<td>Add objects to the User Interface in Graco Gateway.</td>
</tr>
<tr>
<td></td>
<td>Backlight is off.</td>
<td>Push one of the soft keys to turn it back on.</td>
</tr>
<tr>
<td></td>
<td>Backlight tube is broken.</td>
<td>Replace the backlight tube.</td>
</tr>
<tr>
<td>Unit continually cycles on and off.</td>
<td>Cross-references between tags, e.g., Var1 uses Var2 as maximum which</td>
<td>Remove one of the references or use formula tags for indirect reference,</td>
</tr>
<tr>
<td></td>
<td>in turn uses Var1 as minimum.</td>
<td>e.g., Form1 is equal to Var1 and used in Var2 minimum instead of Var1.</td>
</tr>
<tr>
<td></td>
<td>Database is corrupted.</td>
<td>Create a new database or send to technical support for debugging.</td>
</tr>
<tr>
<td>Unit cycles power after an operation.</td>
<td>Most likely a program going in an endless loop.</td>
<td>Check if the operation launches program containing loops with no exit</td>
</tr>
<tr>
<td>CF LED flashing slowly.</td>
<td>CF card corrupted or invalid.</td>
<td>Format the card from Graco Gateway using the Link &gt; Format Flash menu.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>PROBLEM</th>
<th>CAUSE</th>
<th>SOLUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit shows “Version Mismatch”.</td>
<td>The database currently in the device does not match Graco Gateway’s firmware version. (Message occurs after a download with a new version of C2 interrupted before the database was downloaded.)</td>
<td>Download the database from Graco Gateway again.</td>
</tr>
<tr>
<td>Unit shows “Invalid Database”.</td>
<td>The database in the device is corrupted or there are no databases in the device.</td>
<td>Download a database from Graco Gateway.</td>
</tr>
<tr>
<td>Values show “----”</td>
<td>No communication with target device.</td>
<td>See Serial Communication Troubleshooting (page 38) or Ethernet Communication Troubleshooting (page 39).</td>
</tr>
<tr>
<td>Value does not update.</td>
<td>The tag on the screen is not linked correctly.</td>
<td>Check the tag mapping making sure the target device (PLC, etc.) register is correct. Check the primitive Data Source in the user interface in case the word WAS is displayed. Re-link the tag in this case.</td>
</tr>
<tr>
<td>Value shows +BIG or –BIG.</td>
<td>Not enough digits before the decimal point to show the number. For example, data is 1000.5 and format is three digits before the decimal point and one after.</td>
<td>Increase the number of digits before the decimal point in the tag format.</td>
</tr>
<tr>
<td>Value deviates by a factor of ten.</td>
<td>The tag format is not correct.</td>
<td>Change the decimal point position in the tag format.</td>
</tr>
<tr>
<td>Value is invalid.</td>
<td>Incorrect tag type.</td>
<td>Check if the tag type corresponds to the data type. Is the data a floating point number and thus the tag a real (Pi symbol), and not an integer (X symbol)?</td>
</tr>
<tr>
<td></td>
<td>Incorrect data mapping.</td>
<td>Check if the tag is accessing the correct target device register.</td>
</tr>
<tr>
<td></td>
<td>Incorrect primitive on the display.</td>
<td>Check if the primitive corresponds to the tag type. For example, primitive is a Text Integer so the tag has to be an integer.</td>
</tr>
<tr>
<td></td>
<td>Data received is not what’s expected. For example, bytes reversed in the word.</td>
<td>Use the transform property on the tag to modify the data source. You might have to try multiple solutions to solve the issue.</td>
</tr>
<tr>
<td>PROBLEM</td>
<td>CAUSE</td>
<td>SOLUTION</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Symbol or image leaves a trace when animated.</td>
<td>The background of the image is not refreshed.</td>
<td>Change the primitive Fill Format to Solid color.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Add the system variable dispcount in the background of the image to force the refresh.</td>
</tr>
<tr>
<td>Rich Bar Graph or Dial Gauge does not move</td>
<td>Tag minimum and maximum are not setup.</td>
<td>Check the tag’s minimum and maximum values. These are used by both primitives for minimum and maximum.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trend Viewer curve stuck at the bottom.</td>
<td>No minimum and maximum setup on the data tags displayed in the viewer.</td>
<td>Check that all displayed tags in the trend viewer have a Minimum and a Maximum setup.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USB Drivers location for Windows.</td>
<td>Location of the drivers unknown.</td>
<td>The drivers are located under Graco Gateway 2.0\Device installation folder. For example C:\Program Files\Graco Gateway\Device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USB Driver installation.</td>
<td>The operating system is unable to find the driver or the installation failed.</td>
<td>In your operating system device manager, check if the Graco Gateway is present. If so, uninstall that device. Follow the USB installation guide.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Upgrading Graco Gateway did not upgrade the software version.</td>
<td>The option selected during the upgrade was Modify instead of Repair.</td>
<td>Launch the upgrade again and choose Repair when prompted.</td>
</tr>
</tbody>
</table>
### Graco Gateway Messages Troubleshooting

<table>
<thead>
<tr>
<th>PROBLEM</th>
<th>CAUSE</th>
<th>SOLUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device incompatible with file.</td>
<td>The device you are trying to download into doesn't match the database device.</td>
<td>Create a new database file corresponding to your device (File &gt; New).</td>
</tr>
<tr>
<td>Unable to open communication port.</td>
<td>The communication port you try to download with is unavailable:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Cable not connected.</td>
<td>Check if the cable is connected correctly to the PC and the device programming ports (USB or PG Port).</td>
</tr>
<tr>
<td></td>
<td>• Incorrect download communication port.</td>
<td>Check that Graco Gateway is directed to the correct communication port (Link &gt; Options).</td>
</tr>
<tr>
<td></td>
<td>• Port already used.</td>
<td>Check that the communication port is not used by another service or software especially for serial ports.</td>
</tr>
<tr>
<td></td>
<td>• Target device IP address incorrect.</td>
<td>If you download via Ethernet, check the IP address of the target device in Link &gt; Options.</td>
</tr>
<tr>
<td></td>
<td>• No USB Drivers.</td>
<td>Check that the USB drivers were installed successfully. Reinstall Graco Gateway USB driver under the PC device manager if necessary.</td>
</tr>
<tr>
<td>No reply from terminal.</td>
<td>Cable is not connected.</td>
<td>Make sure the cable is connected or check above solutions.</td>
</tr>
<tr>
<td></td>
<td>If the message appears while downloading to the device.</td>
<td>Download again with Link &gt; Update or F9.</td>
</tr>
<tr>
<td>CompactFlash required for upgrade.</td>
<td>The version of Graco Gateway on the PC is different from the target device firmware version when attempting a download via Ethernet.</td>
<td>Insert a CompactFlash Card in the target device.</td>
</tr>
<tr>
<td></td>
<td>Use another communication port for download: USB or Serial.</td>
<td></td>
</tr>
<tr>
<td>The window is too small to allow editing.</td>
<td>The current User interface view is too small to allow editing.</td>
<td>Change the panel view using View &gt; Panel &gt; Display only.</td>
</tr>
<tr>
<td>The device returned an unexpected reply code.</td>
<td>The device you are trying to download to is not supported by this version of Graco Gateway.</td>
<td>Update Graco Gateway to the latest version available (contact your Graco distributor or Graco Technical Assistance). Choose Repair when upgrading.</td>
</tr>
</tbody>
</table>
**Serial Communication Troubleshooting**

This section is used to troubleshoot the communication between two devices linked via serial ports, i.e. RS232 or RS485.

**TIP:** For communication troubleshooting, it is strongly advised to create a new Graco Gateway database including only one data tag mapped to a known register in the target device.

<table>
<thead>
<tr>
<th>PROBLEM</th>
<th>CAUSE</th>
<th>SOLUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Values show “----”</td>
<td>Port settings do not match.</td>
<td>Check that the port settings of the Graco Gateway device match the target device (i.e. Baud, Parity, etc.).</td>
</tr>
<tr>
<td>Incorrect target device address.</td>
<td></td>
<td>Check that the target device address in Graco Gateway (in communications on the PLC symbol) matches the target device address setup.</td>
</tr>
<tr>
<td>Incorrect cable.</td>
<td></td>
<td>Check the cable part number or cabling to match your protocol.</td>
</tr>
<tr>
<td>Incorrect communication port.</td>
<td></td>
<td>Check if the cable is connected to the correct communication port. If the above is correct, check that the protocol settings are on the correct communication port in Graco Gateway.</td>
</tr>
<tr>
<td>Communication port connector pins bent inward.</td>
<td></td>
<td>Although unlikely, check the communication port connector pins on the Graco Gateway in case some are bent inward resulting in a bad contact with the cable.</td>
</tr>
<tr>
<td>Incorrect tag mapping.</td>
<td></td>
<td>Check that the tag is mapped to an existing register in the target device.</td>
</tr>
<tr>
<td>Values blink between the data and “----”</td>
<td>Incorrect tag mapping on one of the tags on the display.</td>
<td>Delete tags one after another and download in-between. When the values on the screen stop blinking, the last deleted tag was mapped incorrectly or accessed an unknown register in the target device.</td>
</tr>
<tr>
<td>Communications times-out.</td>
<td></td>
<td>Increase the Slave Response or Device Timeout on the communication port or target device in Graco Gateway.</td>
</tr>
</tbody>
</table>
## Ethernet Communication Troubleshooting

This section is used to troubleshoot the communication between two devices linked via Ethernet.

**TIP:** For communication troubleshooting, it is strongly advised to create a new Graco Gateway database including only one data tag mapped to a known register in the target device.

<table>
<thead>
<tr>
<th>PROBLEM</th>
<th>CAUSE</th>
<th>SOLUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Values show “----”</td>
<td>Incorrect target device IP address.</td>
<td>Check the target device IP address in Graco Gateway (in communications on the PLC symbol) to match the target device IP address setup.</td>
</tr>
<tr>
<td></td>
<td>Incorrect cable or wrong connection.</td>
<td>Check the LED on the Graco Gateway device Ethernet port. If none are lit, there are no connections. Check the cable or that the Ethernet port is enabled in Graco Gateway, see below.</td>
</tr>
<tr>
<td></td>
<td>Ethernet port disabled.</td>
<td>Check that the Ethernet port in Graco Gateway is enabled.</td>
</tr>
<tr>
<td></td>
<td>Graco Gateway and target devices are in a different address domain:</td>
<td>Check that the target device IP address and Graco Gateway device IP address are different but in the same domain. (For example, both start with the same three first numbers; ex: 192.168.2.xxx if the mask is 255.255.255.0).</td>
</tr>
<tr>
<td></td>
<td>• If no routers are present on the network.</td>
<td>Check the Graco Gateway device Ethernet port Gateway address to match the router IP address.</td>
</tr>
<tr>
<td></td>
<td>• If a router is present on the network.</td>
<td>Check that the tag is mapped to an existing register in the target device.</td>
</tr>
<tr>
<td>Values blink between the data and “----”</td>
<td>Incorrect tag mapping on one of the tags on the display.</td>
<td>Delete tags one after another and download in-between. When the values on the screen stop blinking, the last deleted tag was mapped incorrectly or accessed an unknown register in the target device.</td>
</tr>
<tr>
<td>Communications times-out.</td>
<td>Increase the Slave Response or Device Timeout on the communication port or target device in Graco Gateway.</td>
<td></td>
</tr>
</tbody>
</table>
LED Functions

Status (STS) LED
The green Status LED provides information on the status of the Graco Gateway, including various stages of the startup routine and any errors that occur.

<table>
<thead>
<tr>
<th>Status</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rapidly Flashing</td>
<td>Graco Gateway is currently running the boot loader and/or being upgraded.</td>
</tr>
<tr>
<td>Steady</td>
<td>Graco Gateway is operating normally.</td>
</tr>
</tbody>
</table>

User Communication Ports - TX/RX LEDs

<table>
<thead>
<tr>
<th>Status</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Transmitting</td>
</tr>
<tr>
<td>Red</td>
<td>Receiving</td>
</tr>
</tbody>
</table>

Ethernet LEDs

<table>
<thead>
<tr>
<th>Status</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yellow (Steady)</td>
<td>Link Established</td>
</tr>
<tr>
<td>Yellow (Flashing)</td>
<td>Network Activity</td>
</tr>
<tr>
<td>Green</td>
<td>10 BASE-T Communications</td>
</tr>
<tr>
<td>Amber</td>
<td>10 BASE-TX Communications</td>
</tr>
</tbody>
</table>

CompactFlash (CF) LED

<table>
<thead>
<tr>
<th>Status</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>No CompactFlash card is present.</td>
</tr>
<tr>
<td>Steady</td>
<td>Valid CompactFlash card is present.</td>
</tr>
<tr>
<td>Rapidly Flickering</td>
<td>CompactFlash card is being checked.</td>
</tr>
<tr>
<td>Flickering</td>
<td>Unit is writing to the CompactFlash card, either to store data or because the PC connected via the USB port has locked the drive.*</td>
</tr>
<tr>
<td>Slowly Flashing</td>
<td>Incorrectly formatted CompactFlash card is present.</td>
</tr>
</tbody>
</table>

* Do not turn off power to the unit while this light is flickering. The unit writes data in two minute intervals. Later Microsoft operating systems will not lock the drive unless they need to write data; Windows 98 may lock the drive any time it is mounted, thereby interfering with logging. Contact Graco Technical Assistance for further information.
Model 25B471

15V339, ENCLOSURE

121994, PATCH CABLE, 4

GND

+ -

555770, GREEN, 3
547005, BLUE, 2
065145, BLUE, 1

PORT A
RS232(PGM)
PORT B
RS485
PORT C
RS232
USB HOST
ETHERNET
USB DEVICE

18C235
GATEWAY
MODULE

15V344
TERMINAL
ADAPTER

RJ45 PORT

19Y920
POWER SUPPLY

112443
GND. TERM. BLOCK

223547
GND. WIRE CLAMP

AC POWER INPUT
REFERENCE ONLY

15V339, ENCLOSURE

121994, PATCH CABLE, 4

GND

+ -

555770, GREEN, 3
547005, BLUE, 2
065145, BLUE, 1

PORT A
RS232(PGM)
PORT B
RS485
PORT C
RS232
USB HOST
ETHERNET
USB DEVICE

18C235
GATEWAY
MODULE

15V344
TERMINAL
ADAPTER

RJ45 PORT

19Y920
POWER SUPPLY

112443
GND. TERM. BLOCK

223547
GND. WIRE CLAMP

AC POWER INPUT
REFERENCE ONLY

15V339, ENCLOSURE

121994, PATCH CABLE, 4

GND

+ -

555770, GREEN, 3
547005, BLUE, 2
065145, BLUE, 1

PORT A
RS232(PGM)
PORT B
RS485
PORT C
RS232
USB HOST
ETHERNET
USB DEVICE

18C235
GATEWAY
MODULE

15V344
TERMINAL
ADAPTER

RJ45 PORT

19Y920
POWER SUPPLY

112443
GND. TERM. BLOCK

223547
GND. WIRE CLAMP

AC POWER INPUT
REFERENCE ONLY

15V339, ENCLOSURE

121994, PATCH CABLE, 4

GND

+ -

555770, GREEN, 3
547005, BLUE, 2
065145, BLUE, 1

PORT A
RS232(PGM)
PORT B
RS485
PORT C
RS232
USB HOST
ETHERNET
USB DEVICE

18C235
GATEWAY
MODULE

15V344
TERMINAL
ADAPTER

RJ45 PORT

19Y920
POWER SUPPLY

112443
GND. TERM. BLOCK

223547
GND. WIRE CLAMP

AC POWER INPUT
REFERENCE ONLY

15V339, ENCLOSURE

121994, PATCH CABLE, 4

GND

+ -

555770, GREEN, 3
547005, BLUE, 2
065145, BLUE, 1

PORT A
RS232(PGM)
PORT B
RS485
PORT C
RS232
USB HOST
ETHERNET
USB DEVICE

18C235
GATEWAY
MODULE

15V344
TERMINAL
ADAPTER

RJ45 PORT

19Y920
POWER SUPPLY

112443
GND. TERM. BLOCK

223547
GND. WIRE CLAMP

AC POWER INPUT
REFERENCE ONLY

15V339, ENCLOSURE

121994, PATCH CABLE, 4

GND

+ -

555770, GREEN, 3
547005, BLUE, 2
065145, BLUE, 1

PORT A
RS232(PGM)
PORT B
RS485
PORT C
RS232
USB HOST
ETHERNET
USB DEVICE

18C235
GATEWAY
MODULE

15V344
TERMINAL
ADAPTER

RJ45 PORT

19Y920
POWER SUPPLY

112443
GND. TERM. BLOCK

223547
GND. WIRE CLAMP

AC POWER INPUT
REFERENCE ONLY

15V339, ENCLOSURE

121994, PATCH CABLE, 4

GND

+ -

555770, GREEN, 3
547005, BLUE, 2
065145, BLUE, 1

PORT A
RS232(PGM)
PORT B
RS485
PORT C
RS232
USB HOST
ETHERNET
USB DEVICE

18C235
GATEWAY
MODULE

15V344
TERMINAL
ADAPTER

RJ45 PORT

19Y920
POWER SUPPLY

112443
GND. TERM. BLOCK

223547
GND. WIRE CLAMP

AC POWER INPUT
REFERENCE ONLY

15V339, ENCLOSURE

121994, PATCH CABLE, 4

GND

+ -

555770, GREEN, 3
547005, BLUE, 2
065145, BLUE, 1

PORT A
RS232(PGM)
PORT B
RS485
PORT C
RS232
USB HOST
ETHERNET
USB DEVICE

18C235
GATEWAY
MODULE

15V344
TERMINAL
ADAPTER

RJ45 PORT

19Y920
POWER SUPPLY

112443
GND. TERM. BLOCK

223547
GND. WIRE CLAMP

AC POWER INPUT
REFERENCE ONLY

15V339, ENCLOSURE

121994, PATCH CABLE, 4

GND

+ -

555770, GREEN, 3
547005, BLUE, 2
065145, BLUE, 1

PORT A
RS232(PGM)
PORT B
RS485
PORT C
RS232
USB HOST
ETHERNET
USB DEVICE

18C235
GATEWAY
MODULE

15V344
TERMINAL
ADAPTER

RJ45 PORT

19Y920
POWER SUPPLY

112443
GND. TERM. BLOCK

223547
GND. WIRE CLAMP

AC POWER INPUT
REFERENCE ONLY

15V339, ENCLOSURE

121994, PATCH CABLE, 4

GND

+ -

555770, GREEN, 3
547005, BLUE, 2
065145, BLUE, 1

PORT A
RS232(PGM)
PORT B
RS485
PORT C
RS232
USB HOST
ETHERNET
USB DEVICE

18C235
GATEWAY
MODULE

15V344
TERMINAL
ADAPTER

RJ45 PORT

19Y920
POWER SUPPLY

112443
GND. TERM. BLOCK

223547
GND. WIRE CLAMP

AC POWER INPUT
REFERENCE ONLY

15V339, ENCLOSURE

121994, PATCH CABLE, 4

GND

+ -

555770, GREEN, 3
547005, BLUE, 2
065145, BLUE, 1

PORT A
RS232(PGM)
PORT B
RS485
PORT C
RS232
USB HOST
ETHERNET
USB DEVICE

18C235
GATEWAY
MODULE

15V344
TERMINAL
ADAPTER

RJ45 PORT

19Y920
POWER SUPPLY

112443
GND. TERM. BLOCK

223547
GND. WIRE CLAMP

AC POWER INPUT
REFERENCE ONLY

15V339, ENCLOSURE

121994, PATCH CABLE, 4

GND

+ -

555770, GREEN, 3
547005, BLUE, 2
065145, BLUE, 1

PORT A
RS232(PGM)
PORT B
RS485
PORT C
RS232
USB HOST
ETHERNET
USB DEVICE

18C235
GATEWAY
MODULE

15V344
TERMINAL
ADAPTER

RJ45 PORT

19Y920
POWER SUPPLY

112443
GND. TERM. BLOCK

223547
GND. WIRE CLAMP

AC POWER INPUT
REFERENCE ONLY

15V339, ENCLOSURE

121994, PATCH CABLE, 4

GND

+ -

555770, GREEN, 3
547005, BLUE, 2
065145, BLUE, 1

PORT A
RS232(PGM)
PORT B
RS485
PORT C
RS232
USB HOST
ETHERNET
USB DEVICE

18C235
GATEWAY
MODULE

15V344
TERMINAL
ADAPTER

RJ45 PORT

19Y920
POWER SUPPLY

112443
GND. TERM. BLOCK

223547
GND. WIRE CLAMP

AC POWER INPUT
REFERENCE ONLY

15V339, ENCLOSURE

121994, PATCH CABLE, 4

GND

+ -

555770, GREEN, 3
547005, BLUE, 2
065145, BLUE, 1

PORT A
RS232(PGM)
PORT B
RS485
PORT C
RS232
USB HOST
ETHERNET
USB DEVICE

18C235
GATEWAY
MODULE

15V344
TERMINAL
ADAPTER

RJ45 PORT

19Y920
POWER SUPPLY

112443
GND. TERM. BLOCK

223547
GND. WIRE CLAMP

AC POWER INPUT
REFERENCE ONLY
System Electrical Schematics

Models 25B472 and 25B473

[Diagram showing electrical schematics for Models 25B472 and 25B473, including GND TERM. BLOCK, POWER SUPPLY, RJ45 PORT, TERMINAL ADAPTER, GATEWAY MODULE, ENCLOSURE, and external controller network cable.]
Parts

25B471 Gateway Ethernet Kit
Parts

25B472 Gateway DeviceNet Kit

25B473 Gateway Profibus Kit
### 25B471, 25B472, and 25B473 Parts List

<table>
<thead>
<tr>
<th>Ref. No.</th>
<th>Part No.</th>
<th>Description</th>
<th>Qty</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>15V339</td>
<td>PANEL, back</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>25P012</td>
<td>COVER</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>16M007</td>
<td>SCREW, machine, serrated hex head</td>
<td>4</td>
</tr>
<tr>
<td>4</td>
<td>116343</td>
<td>SCREW, ground</td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>186620</td>
<td>LABEL, ground</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Model 25B471 only</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Models 25B472 and 25B473</td>
<td>3</td>
</tr>
<tr>
<td>6</td>
<td>514014</td>
<td>RAIL, mount</td>
<td>1</td>
</tr>
<tr>
<td>7</td>
<td>103833</td>
<td>SCREW, machine, pan head</td>
<td>4</td>
</tr>
<tr>
<td>8</td>
<td>120838</td>
<td>BLOCK, clamp end</td>
<td>2</td>
</tr>
<tr>
<td>9</td>
<td>112443</td>
<td>BLOCK, terminal ground</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Model 25B471 only</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Models 25B472 and 25B473</td>
<td>2</td>
</tr>
<tr>
<td>10</td>
<td>19V920</td>
<td>SUPPLY UNIT, power</td>
<td>1</td>
</tr>
<tr>
<td>13</td>
<td>15V344</td>
<td>CONNECTOR, terminal adapter</td>
<td>1</td>
</tr>
<tr>
<td>14</td>
<td>18C235</td>
<td>MODULE, protocol converter and data acquisition system</td>
<td>1</td>
</tr>
<tr>
<td>15</td>
<td></td>
<td>CARD, expansion</td>
<td></td>
</tr>
<tr>
<td></td>
<td>18C236</td>
<td>DeviceNet (model 25B472 only)</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>18C237</td>
<td>PROFIBUS (model 25B473 only)</td>
<td>1</td>
</tr>
<tr>
<td>16</td>
<td>15V345</td>
<td>grommet, cable entry system</td>
<td>2</td>
</tr>
<tr>
<td>17</td>
<td>15V346</td>
<td>WIREWAY, base</td>
<td>1</td>
</tr>
<tr>
<td>18</td>
<td>15V580</td>
<td>WIREWAY, cover</td>
<td>1</td>
</tr>
<tr>
<td>20</td>
<td>15U918</td>
<td>LABEL, product</td>
<td>1</td>
</tr>
<tr>
<td>22</td>
<td>293555</td>
<td>ARTWORK, label, gateway module</td>
<td>1</td>
</tr>
<tr>
<td>23</td>
<td>15W776</td>
<td>LABEL, warning, electrical</td>
<td>1</td>
</tr>
<tr>
<td>24</td>
<td>121994</td>
<td>CABLE, cat5</td>
<td>1</td>
</tr>
<tr>
<td>25</td>
<td>121700</td>
<td>CABLE, 2 conductor</td>
<td>1</td>
</tr>
<tr>
<td>26</td>
<td>065145</td>
<td>WIRE, copper electrical</td>
<td>1</td>
</tr>
<tr>
<td>27</td>
<td>112515</td>
<td>FERRULE, wire red</td>
<td>4</td>
</tr>
<tr>
<td>28</td>
<td>547005</td>
<td>WIRE, copper 16 ga</td>
<td>1</td>
</tr>
<tr>
<td>29</td>
<td>114090</td>
<td>TERMINAL (models 25B472 and 25B473)</td>
<td>1</td>
</tr>
<tr>
<td>30</td>
<td>555770</td>
<td>WIRE, 18 ga</td>
<td>1</td>
</tr>
<tr>
<td>31</td>
<td>112514</td>
<td>FERRULE, wire, awg-18</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Model 25B471 only</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Models 25B472 and 25B473</td>
<td>3</td>
</tr>
<tr>
<td>33</td>
<td>17R419</td>
<td>MEDIA, sd flash card, 2 gb</td>
<td>1</td>
</tr>
<tr>
<td>34</td>
<td>15T999</td>
<td>CABLE, usb</td>
<td>1</td>
</tr>
<tr>
<td>38</td>
<td>223547</td>
<td>WIRE, assembly</td>
<td>1</td>
</tr>
</tbody>
</table>

▲ Replacement Danger and Warning labels, tags, and cards are available at no cost.

Parts labeled n/a are not available separately.

**NOTE:** All brand names or marks are used for identification purposes and are trademarks of their respective owners.
Appendix A: DeviceNet™ Slave Communication

Overview

This appendix describes the Gateway’s support for DeviceNet and details the configuration steps necessary to use this feature. It does not provide a detailed description of DeviceNet, but only a brief introduction, necessary to define the terms that are used throughout the remainder of this document.

Introduction

DeviceNet is a low-level network using the Controller Area Network (CAN) technology, to provide communication between a range of industrial devices, from simple devices such as sensors and actuators, to high-level devices such as controllers and HMIs.

DeviceNet Port Protocols

The DeviceNet option card has one DeviceNet port. See Fig. 31. The port may be configured for variousDeviceNet protocols. Contact Graco Technical Assistance for currently supported protocols.

Also see Appendix A: DeviceNet™ Slave Communication on page 47.

DeviceNet Option Card Pin Outs

- **V-**
  Position 1 of the pluggable connector provides a CAN ground connection. This terminal is isolated from the Graco Gateway.

- **CAN_L**
  Position 2 of the pluggable connector provides the CAN_L bus line (active low). This terminal is isolated from the Graco Gateway.

- **DRAIN (optional)**
  Position 3 of the pluggable connector is provided for optional drain connections. This position is available only to tie drain wires together or to earth ground. There is no internal connection to earth ground. The DRAIN position is not connected to any circuitry internal to the DeviceNet option card.

- **CAN_H**
  Position 4 of the pluggable connector provides the CAN_H bus line (active high). This terminal is isolated from the Graco Gateway.

- **V+ (optional 24 Vdc)**
  Position 5 of the pluggable connector is provided for optional 24 Vdc connections. This position is available only to tie 24 Vdc wires together. The DeviceNet option card neither provides or uses 24 Vdc power through this connection. The V+ position is not connected to any circuitry internal to the DeviceNet option card or Graco Gateway.
Fig. 31: DeviceNet Port Pin Outs and PLC Connection
About DeviceNet

DeviceNet is a connection-based network. In this context the term connection refers to a communication path between two or more devices, and not the physical (cable) connection to the DeviceNet network. A connection must be established between two devices in order to transfer data.

There are two types of connection defined by the DeviceNet specification. Each has different characteristics and is suited to a specific type of communication.

- **I/O Connection** – Dedicated data transfer between a producer and one or more consumers. The format of the data is known or implied by the connection.

- **Explicit Messaging** – Generic multi-purpose messaging connection, typically command and response message commands.

Each connection type has an extensive number of parameters, which can affect the characteristics of the communication path. For many Master/Slave communications scenarios, a defined set of connections, together with their respective parameter settings exist under the collective name Predefined Master/Slave Connection Set. Many of the steps involved in creating and configuring a connection have been removed with this connection set, thus simplifying the network configuration.

Predefined Master/Slave Connection Set

The DeviceNet specification details a number of connections that facilitate data transfer between a Master and Slave devices. The following sections detail the connection types supported by the Gateway.

- **I/O Bit-Strobe Connection**: The Bit-Strobe connection is an I/O connection over which Bit-Strobe I/O command and response messages are transferred. The Bit-Strobe command is broadcast by the Master device and is received by all slave devices simultaneously. The command message contains a single bit of information for each slave on the network. Each slave device is required to respond with a Bit-Strobe response message. The response message can contain up to 8 bytes of information.

- **I/O Poll Connection**: The Poll connection is an I/O connection over which Poll command and response messages are transferred. The Poll command is transmitted by the master, and is directed to a single slave device. The slave device in turn responds with a Poll response message. Both the Poll command and Poll response messages can contain any number of bytes.

- **I/O Data Connection**: The I/O Data connection is part of the Predefined Master/Slave Connection Set, but instead is included for devices, which support creating I/O data connections via the UCMM (Unconnected Message Manager).

Level of Support

The Gateway provides Group 2 Server level support: A UCMM capable device that is configured to act as a Slave for the Predefined Master/Slave connection set.
Appendix A: DeviceNet™ Slave Communication

Hardware
To use DeviceNet on the Gateway, an option card must first be installed. The option card provides the hardware necessary to support the CAN physical layer specification as required by the DeviceNet standard.

Configuring the option card is a two-stage process; first the option card must be selected in Gateway (DeviceNet Option Card), and then the 'DeviceNet Predefined Group 2 Server Driver' configured to run on the newly created DeviceNet Interface port.

Gateway Configuration
The following example requires use of an Allen Bradley 1756-ControlLogix PLC, along with RSLogix 5000 and RSNetWorx for DeviceNet software and a Gateway.

Configure the Gateway DeviceNet Option Card
Install the Gateway DN0000 option card in the Gateway as per the provided instructions.

Click on File> New to create a new Gateway database and select Gateway Series HMI – Gateway 10.

Enter the Communications section. In the tree on the left, select Gateway from the top of the tree. Select the Edit button at the right, and select the DeviceNet Option Card from the dialog box as shown in Fig. 32. Click OK.

Fig. 32: Select DeviceNet Option Card
The DeviceNet Option card appears at the end of the tree. Select the DeviceNet Interface from under the DeviceNet Option Card item.

On the right hand pane, click on the Edit button to open the driver picker dialog box. Select the DeviceNet Pre-defined Group 2 Server driver. Fig. 33.

Set the appropriate Station Address, Baud Rate, and I/O Poll Size. Make sure the Data Format Settings are set to Transform: Swap Bytes In Word. Fig. 34.
IMPORTANT NOTE: The I/O Polled Size is determined by the settings in both the DeviceNet Master and the registered .EDS file for the Gateway. To change these settings, see Automatic Update of the EDS File on page 56 before setting up the PLC.

**Fig. 34: Device Settings**
Create Gateway Blocks

Select the DeviceNet device from the tree at the left, and add two Gateway Blocks; one for Read Data and one for Write Data, using the Add Gateway Block button on the right hand pane.

Select the first Gateway Block and select the Edit button at the right.

Set the block for I/O Polled Command Data, starting at element PollC 00000. Fig. 36.
NOTE: For 16-bit support, select Word as Word. For 32-bit support, select Word as Long. The latter is recommended as DeviceNet uses 32 bits integer addressing.

Set the block size for 4, and the Direction for: Device To Gateway. This will be the Read Data block.

Fig. 36: Select Data Type (Word as Long)
Select the second Gateway Block and set it up for I/O Polled Response Data 00000, with a length of 4, and the Direction Gateway To Device. This will be the Write Data Block. Fig. 37 shows both Gateway blocks once completed.

**NOTE:** Read and Write are from the Gateway point of view. This means the master can send data in Block A, so the Gateway can read data. On the other hand, the master can only pull data from Block B, so the Gateway can only write data.

The addressing scheme available is outlined below:

BitC – Identifies the I/O Bit-Strobe command data (Master to Slave).

BitR – Identifies the I/O Bit-Strobe response data (Slave to Master).

PollC – Identifies the I/O Poll command data (Master to Slave).

PollR – Identifies the I/O Poll response data (Slave to Master).

DataC – Identifies the I/O Consumed Data (Master to Slave).

DataP – Identifies the I/O Produced Data (Slave to Master).
Automatic Update of the EDS File

DeviceNet nodes use an EDS (Electronic Data Sheet) to describe the communications parameters available at each device on the DeviceNet network.

By design, each DeviceNet master can handle a maximum of 124 Input words and 123 Output words. In the default EDS file for the Gateway, the Input and Output data sizes are set at 16 bytes each. This equates to four words of data input and four words of data output. These values can be set higher, but it is important to note that if the default values are set higher, they might conflict with other DeviceNet implementations.

Gateway provides an EDS file generator tool to create a file that matches your Gateway settings. This file can therefore be used to configure the Master.

To generate this file, enter the Communications module and select the DeviceNet interface on the left. Under the Electronic Data Sheet, select Yes in Synchronize and choose the path and name where the file should be saved using the Browse button. Fig. 38.

Saving the database using the File>Save command will synchronize and therefore update the EDS file.

Each time EDS parameters are modified, the EDS file will need to be re-registered within RSNetWorx for DeviceNet. These changes will also need to be reflected in the following locations:

- RSNetWorx master node Scanlist, Input Table, and Output Table
- ControlLogix PLC DeviceNet Scanner configuration

**NOTE:** Inputs and Outputs are with respect to the master, therefore inputs refer to data sent from the slave and read by the master.

![Gateway provided an EDS file generator tool to create a file that matches your Gateway settings. This file can therefore be used to configure the Master.](image)
Appendix A: DeviceNet™ Slave Communication

Configure the RSNetWorx for DeviceNet Software

RSNetWorx for DeviceNet is used to set up and manage a DeviceNet network. To begin the configuration, launch RSNetWorx for DeviceNet from your development PC.

Start a new network by selecting: File>New>DeviceNet Configuration.

Register the EDS file generated by Gateway as shown in the previous section of this document by selecting: Tools>EDS Wizard>Register an EDS file(s).

Make sure that the .EDS file validation is successful.

If desired, select a new image file to represent the Gateway.

Select Register a single file, and browse to the location where you saved the Gateway.EDS file.

Fig. 39: Register the EDS File

Fig. 40: Browse to Graco Gateway EDS File

Fig. 41: EDS Validation

Fig. 42: EDS Image File
Review the EDS registration, and finish the process.

Select the DeviceNet Master by navigating in the tree on the left hand side. Navigate to: DeviceNet>Cate-
gory>Communication Adapter>1756-DNB/A. Select the appropriate Major Rev and drag it into the network work-
space at the right.

Select the Gateway Slave by navigating in the tree on the left. Navigate to: DeviceNet>Vendor>Graco Con-
trols>Generic Device. Select the Gateway-SERVER and drag it into the network workspace at the right.

Configure the master to add the slave device to the scanlist. Right click the DNB module and select proper-
ties.

From the Scanlist tab, select the Gateway-SERVER from the Available Devices pane, and add it to the Scan-
list pane. Select the Edit I/O Parameters button.

![Review EDS Registration](image1)

![Configure the DeviceNet Master](image2)
Appendix A: DeviceNet™ Slave Communication

Make sure that the Strobed or Change of State boxes are not selected. In the Polled section, verify that the Input and Output sizes are 16 bytes. These must match the I/O Poll Size selections made above in the Gateway. In DeviceNet networks, 4 bytes constitute a full word. Therefore the 16 bytes selection represents 4 full words of addressable 32-bit data.

Select the Input tab. Verify that the four words of Gateway-SERVER data are mapped to YourDNBSlot:I.Data[0…3]. From the Output tab, verify that the four words are mapped to YourDNBSlot:O.Data[0…3]. Apply the changes, and save your RSNetWorx for DeviceNet configuration.

Fig. 45: Apply and Save
Configure the Allen Bradley ControlLogix PLC

Allen Bradley ControlLogix PLCs are programmed with RSLogix 5000 programming software. To begin the DeviceNet configuration, launch RSLogix 5000 from your development PC.

Create a ControlLogix program containing a valid DeviceNet Scanner. In this application a 1756-DNB was used.

Fig. 46: Create Valid DeviceNet Scanner
Configure the DeviceNet Scanner to be address 0. Make sure to set up the 32-bit Input and Output memory spaces for a size of 32 (to match the configuration made above in both Gateway and RSNetWorx for DeviceNet).

Select the RSNetWorx tab, and navigate to the RSNetWorx for DeviceNet configuration that you have previously created. Open the configuration from here and download it to the network.

In the Main Task tree, open the Main Routine Ladder Logic file. Create a rung of ladder to enable the DeviceNet network. The required output is always:

**Local:YourDNBSlot:0.CommandRegister.Run**

Create a few rungs by taking the DeviceNet Input data, Local:2.I.Data[0…3], and adding 1 to them. Store the results in Local:2.O.Data[0…3]. Based on the configuration in the Gateway, if values are changed on the Gateway Write tags, the Read tags will display the respective values, plus one.

Save and download this configuration to the ControlLogix PLC.

**Wire the DeviceNet Network**

All DeviceNet networks require a termination resistor at the two end nodes on the network. Place a ¼ watt 120 ohm resistor between CAN H (White) and CAN L (Blue) of the DeviceNet connection.
Appendix B: Profibus™ DP Slave Communication

Overview
This appendix describes the Gateway’s support for Profibus DP and details the configuration steps necessary to set up a Graco Gateway with an S7300 PLC, CPU315-2DP via Profibus. It does not provide a detailed description of Profibus, but only a brief introduction, necessary to define the terms that are used throughout the remainder of this document.

Introduction
Profibus DP stands for “Profibus for Decentralized Peripherals”. Profibus DP is a device level bus that supports both analog and discrete signals. It has widespread usage for such items as remote I/O systems, motor control centers, and variable speed drives. Profibus DP communicates at speeds from 9.6 Kbps to 12 Mbps over distances from 100 to 1,200 meters.

The protocol supported by the Profibus DP option card is Profibus DP Slave. Therefore, the Graco Gateway must be linked to a Profibus network with a PLC.

Profibus Port Protocols
The Profibus option card has one Profibus port. See Fig. 48.

Also see Appendix B: Profibus™ DP Slave Communication on page 62.
About Profibus DP

Profibus DP communication takes the form of block exchange. Profibus blocks are made of memory bytes where 2 bytes make a word and 4 bytes a double word, or Dword.

A block is a range of consecutive byte addresses and is unidirectional. This means the PLC will exchange data read only and write only blocks with DP slave units. Addresses in each device are independent and only relevant to the device for its own program. For example, the address range for the first block in the master can start at 256 with a 64 words block length and could result in the slave with a range starting from 0 with 64 words length.

However, since blocks are consecutive, this means the first block start address, in the above example 256, will be the slave start address 0. Then, 257 in the master would be 1 in the slave, and so on.

Block length can be defined in bytes, words, or double words. Since start addresses between the master and the slave can be different, one could give its start address and length in bytes, and the other in words.

For example, the master start address is byte 256, with a 64 words block length.

- This results in a range from byte 256 up to byte 383. The slave start address is word 0, with a 64 words block length.

- This results in a range from word 0 to word 63. Fig. 49 illustrates this exchange.

**NOTE:** Do not forget that the Input block is independent from the Output block, and although the address range is the same, the data are different.

**NOTE:** Fig. 49 has no connection with the Input Block and Output Block in Graco Gateway. The terminology used in the tags configuration is from the PLC point of view (DP Master). Refer to [Graco Gateway Setup](#) for more information.

---

**Fig. 49: Master/Slave Exchange**

![Diagram of Master/Slave Exchange](#)
Setup the PLC

The Siemens Simatic Manager software is used to set up the S7300 PLC. The following figures and explanations are extracted from this software.

Install the GSD file

The first step is to install the GSD file so Simatic is able to map data blocks to our device. Contact Graco Technical Assistance for Profibus GSD files.

Start Simatic Manager and open or create a new PLC project. Select the Simatic 300 Station in the navigation pane as shown in Fig. 50.

Double-click Hardware in the right hand window. This will start the HWConfig where most of the work is done. The HWConfig shows the current PLC hardware configuration. Close this configuration (NOT HWConfig) and choose Options>Install GSD File... Fig. 51.
Appendix B: Profibus™ DP Slave Communication

Click Browse to select the folder where the GSD file downloaded previously is, select the file and click Install. Fig. 52.

Once the GSD file is installed successfully, the PLC hardware setup can be opened again by doing Station and selecting the latest opened file which should be number 1.

If this is a new project, configure your PLC with the right modules.

---

**Fig. 52: Browse to GSD File**
Setup the Profibus Network

The following steps show how to set up the Profibus DP network. Skip these steps if your PLC application already possesses a Profibus DP network.

In the floating window that represents the PLC, double click the DP area to open the properties window as shown in Fig. 53.

![Fig. 53: DP Properties Window](image-url)

---

Appendix B: Profibus™ DP Slave Communication
In the General tab, click the properties button to open the Profibus properties. Fig. 54.

![Fig. 54: Open Profibus Properties](image)

In the properties window, go to the Parameters tab and click on the New button to create a new network. Fig. 55.

![Fig. 55: Create a New Profibus Network](image)
Select the Network Settings tab and choose the Transmission Rate that fits the application. In this example, it will be 12 Mbps. The profile should be DP. Fig. 56.

![Set Transmission Rate](image)

**Fig. 56: Set Transmission Rate**

Close the popup windows by clicking OK. HWConfig should now show the Profibus DP master system next to the PLC. Fig. 57.

![Profibus DP Master System](image)

**Fig. 57: Profibus DP Master System**
Add the Graco Gateway to the Profibus Network

To add the Graco Gateway to the Profibus network, drag the Gateway Profibus Card from the Catalog navigation situated on the right hand side of HWConfig to the Profibus DP Master System. The card is situated under Profibus DP>Additional Field Devices>MMI.

In the properties window that popped up, select the Profibus address the Gateway will take on the network. This address should be unique. In this example, the Gateway will take address 5. Fig. 58. Click OK.

Fig. 58: Add Graco Gateway to Profibus Network
The Gateway is now on the Profibus DP network and selected. HWConfig shows the slots available under the Gateway to configure the data blocks to exchange.

Just drag and drop one of the data blocks available under the Gateway Profibus Card in the slot number 1. Simatic will automatically assign a start address (byte number) in the respective Input and output columns depending of the block type chosen. In this example, 64 words in and 64 words out.

More blocks can be inserted in the following slots to fit your application. Fig. 59 shows an example with a 16 words input block in slot 2 and 5 words output block in slot 3. Addresses are given automatically but can be edited by the user.

**NOTE:** If the starting address for a block in slot 2 or above changes and creates a gap in the address range, it will not affect the Gateway blocks, as all data are consecutive. It is however advised to keep the addresses consecutive to facilitate development.

![Configure Data Blocks](image)

**Fig. 59: Configure Data Blocks**

Save the configuration and download it to the PLC.

**NOTE:**

- The maximum number of input bytes allowed is 244.
- The maximum number of output bytes allowed is 244.
- The maximum number of bytes overall is 436.
Graco Gateway Setup

Once the PLC is setup, the Gateway can be programmed to fit its configuration.

NOTE: For a Gateway to communicate on Profibus DP, a Profibus Option card has to be fitted in the unit. Refer to the device manual to find the proper option card and installation procedure.

Setup the Profibus Communication

Enter the communication module and select the Gateway. On the right hand pane, click the Edit button to select the Option card. Select Profibus Option card and click OK. Fig. 60.
The option card appeared in the communication tree. Select the Profibus Interface and click the Edit button to select a driver. Click OK to pick the Profibus DP driver. Fig. 61.

Graco Gateway now displays the driver settings where the Station Address can be changed. This address is the Gateway address on the Profibus network. In our example, this address is 5 as setup in the PLC earlier. **NOTE:** There are no Baud Rate settings as the Profibus option card detects the transmission rate automatically.

A device called PLC1 is now displayed under the Profibus Interface. This device represents the Profibus Master and can be renamed to fit the application. In this example, the name PLC1 remains. Fig. 62.
Appendix B: Profibus™ DP Slave Communication

Setup Tags

Once the communication is set up, tags can be created to access the PLC blocks. This is where the section Setup the Profibus Communication, page 71, is important.

First, create a variable that correspond to the data type required. In this example, an integer. Fig. 63.

Select the variable and rename it eventually. Then, click on Internal next to mapping on the right hand side pane, and select PLC1, which is the Profibus Master. Fig. 64.
In the popup window, select the block type required. Two choices are available:

- **Input block**: The terminology input is from the Siemens perspective. Therefore this will be a block the Gateway will write to. The tag mapped to an input block has to be set up as Write Only.

- **Output block**: The terminology output is from the Siemens perspective. Therefore this will be a block the Gateway will read from. The tag mapped to an output block has to be set up as Read Only.

- Select the data offset, which points the address to read or write in the block. Select the data type to read or write. This defines how many bytes to access in the block to get the correct data. In this example we choose **output block**, with data offset 0 (Which points to 256 in the PLC) and as a **Word**. Fig. 65.

**FIG. 65: Select Block Type**

**NOTE**: Since the output block is a reading block from the Gateway standpoint, this variable should be set up as Read Only as shown in Fig. 19. The same rule applies if the block is an input block, it should be set up as Write Only.

To avoid mistakes, the mapping shows with an R or W for output or input block respectively. Fig. 66.

**FIG. 66: Properties of Variable**
How Addressing Works

PLC addressing is in byte and uses the scheme shown in Fig. 67.

The Gateway addressing follows a different scheme, as shown in Fig. 68.

This means that the address number will be different when accessing words or Dwords in the Gateway data tags than the PLC. Table 6 shows the address relationship for integer tags mapped as word in the Gateway.

Note how a Dword or word address starts at the address of the first byte included in it.

FIG. 67. PLC Addressing Scheme

Here, the word or Dword addresses follow the normal numeric increment and are not directly related to the word or bytes they are composed of.

FIG. 68. Gateway Addressing Scheme

Table 6: Addressing Relationship

<table>
<thead>
<tr>
<th>Block Type</th>
<th>PLC Input (bytes)</th>
<th>PLC Output (bytes)</th>
<th>Gateway Input (words)</th>
<th>Gateway Output (words)</th>
</tr>
</thead>
<tbody>
<tr>
<td>64 words in, 64 words out</td>
<td>256...383</td>
<td>256...383</td>
<td>0...63</td>
<td>0...63</td>
</tr>
<tr>
<td>16 words in</td>
<td>384...415</td>
<td>-</td>
<td>64...79</td>
<td>-</td>
</tr>
<tr>
<td>5 words out</td>
<td>-</td>
<td>384...393</td>
<td>-</td>
<td>64...68</td>
</tr>
</tbody>
</table>
Useful Formulas

The following formula can be used to find the byte number from a word address:

\[
\text{ByteAddress} = \text{PLCOffset} + (\text{WordAddress} \times 2), \text{ where:}
\]

- ByteAddress is the address we are looking for in the PLC
- PLCOffset is the first byte number in the complete block mapping in the PLC, here 256
- WordAddress is the address mapped in the Gateway. So, for example, word 77 in the Gateway, would start at byte 410 in the PLC, and so would be composed of byte 410 and 411.

The following formula can be used to find the byte number from a Dword address:

\[
\text{ByteAddress} = \text{PLCOffset} + (\text{DWordAddress} \times 4), \text{ where:}
\]

- ByteAddress is the address we are looking for in the PLC
- PLCOffset is the first byte number in the complete block mapping in the PLC, here 256
- DwordAddress is the address mapped in the Gateway. So, for example, Dword 14 in the Gateway, would start at byte 312 in the PLC, and so would be composed of byte 312, 313, 314 and 315.

**NOTE:** For the formula to work, all the blocks in the PLC Profibus configuration for the Gateway have to be consecutive. Fig. 58.
Appendix C: Graco Gateway to ControlLogix via Ethernet IP

Overview
This appendix describes the configuration steps necessary to establish a communication path between the Graco Gateway and a ControlLogix unit. You will need either a 1756-ENET/B or a 1756-ENBT/A together with a Logix5550 controller. It may be possible to upgrade a 1756-ENET/A to the required 1756-ENET/B by flashing the firmware; you should check the hardware version with your vendor before hand to ensure its suitability. You will also need Rockwell Software’s RSLinx and RSLogix 5000 software configuration utilities.

Introduction
In the following example, the ControlLogix will establish a Class1 connection and I/O data will be exchanged between the ControlLogix and the Graco Gateway terminal. The network parameters used in this example will almost certainly not apply to your application. Be sure to consult your network administrator when selecting appropriate values.

FIG. 69: Ethernet PLC Connection
ControlLogix Configuration

1. Run the RSLogix 5000 program and create a new configuration.

2. Add a 1756-ENET/B or a 1756-ENBT/A to your I/O configuration. You will need to:
   a. Switch to offline mode.
   b. Right click on the I/O Configuration node in the Controller Organizer view and choose Add Module.
   c. In the Select Module Type window, choose 1756-ENET/B or 1756-ENBT/A entry. RSLogix will open the Module Properties window. See FIG. 70.
   d. Enter the IP Address of the ENET/B or ENBT/A interface.
   e. Click Finish to add the interface to your I/O configuration.
   f. Download the configuration.
   g. Switch to online mode and open the 1756-ENET/B or 1756-ENBT/A node properties under the I/O Configuration in the Controller Organizer.
   h. Select the Port Configuration Tab from the Module Properties window. See Fig. 71.
   i. Enter the IP Address and Subnet Mask. The IP Address must match the IP Address entered in the Properties window (Fig. 70).
   j. Apply the settings using the Set button.
   k. You can now verify the network module network communications with your unit using suitable diagnostic tools such as Ping.

3. Add the Graco Gateway to the RSLogix configuration as follows:
   a. Switch to offline mode.
   b. Right click on the 1756-ENET/B or 1756-ENBT/A node under the I/O Configuration in the Controller Organizer view and choose Add Module.
   c. In the Select Module Type window, choose Generic Ethernet Module. See FIG. 72.
   d. Click OK. This will open the Module Properties window. See FIG. 73.
Appendix C: Graco Gateway to ControlLogix via Ethernet IP

**FIG. 71. Port Configuration Window**

**FIG. 72. Ethernet Module Selection**
e. In the Name field, enter a descriptive name to identify the module. See Fig. 73.

f. In the Address/Host Name field, enter the IP Address of the Graco Gateway.

g. Enter 2 in the Input Assembly Connection Point and a size of 2. This will match a read only Slave Gateway block configured in the Gateway, and will be used for reading data from the Gateway to the ControlLogix.

h. Enter 3 in the Output Assembly Connection Point and a size of 2. This will match a read/write Slave Gateway block configured in the Gateway, and will be used for writing data from the ControlLogix to the Gateway.

i. Enter 1 in the Configuration Connection Point and a size of 0. Configuration data is not supported by the Gateway.

j. Press Finish to add the Gateway to the I/O configuration.

The connection points and sizes are arbitrary, as long as the connection point, size, and direction are matched in the configuration of the Gateway.

Connection point direction is always relative to the originator, which in the case of the current Gateway Ethernet/IP implementation is always the device and never the Gateway. An input connection therefore specifies data flow from the Gateway to the device, and an output connection specifies data flow from the device to the Gateway.

![Module Properties - EIP (ETHERNET-MODULE 1.1)](image)

**Fig. 73. Ethernet Module Properties**
See Fig. 74. You should now see a new ETHERNET-MODULE Gateway_HMI branch of the 1756-ENET/B node in the I/O Configuration view. You should also see three new entries in the Controller Tags view:

- Gateway_HMI:I to view the input data
- Gateway_HMI:O to modify the output data
- Gateway_HMI:C to view the configuration data

4. Download the new I/O configuration to the controller. Once the download is complete, the controller will automatically establish a new Class1 connection with the Gateway.

**Fig. 74. Ethernet Configuration Data**
Graco Gateway Configuration

1. **Ethernet Settings.** Set the IP Address to 192.168.2.101. This should match the Address/Host Name entered in Fig. 73.

2. **Protocol Settings.** Select the Ethernet/IP Slave Adapter communications driver.

   The ENET/B module prefixes all output data with a header containing status information about the originator's run/idle state. With the Run/Idle Header checked, the communications driver will automatically process the header, and data will be ignored if the device is in the Idle state. With the option unchecked, extra space must be allocated in the Gateway block to receive the status information; all data is accepted regardless of the device state.

3. **Device Settings.** A Gateway block must be created for each connection point.

   For the purpose of configuring, the data transfer terms *input* and *output* are relative to the device and not the Gateway. An *input* connection is therefore specified as Gateway to Device, and an *output* connection is specified as Device to Gateway.

   Connection point mapping is defined in the Start Address block setting and comprises the connection point instance and a data offset. The instance must match that specified by the originator; the offset can be used to skip over data not required by the Gateway, useful mainly on shared connection points.

---

**FIG. 75. Ethernet Block Settings**
The following settings mirror the I/O settings of the ControlLogix configuration detailed earlier.

a. **Input Connection Point.** Create a Gateway block configuration (see Table 7).

<table>
<thead>
<tr>
<th>Table 7: Input Connection Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Point</td>
</tr>
<tr>
<td>Data Offset</td>
</tr>
<tr>
<td>Data Type</td>
</tr>
<tr>
<td>Block Size</td>
</tr>
<tr>
<td>Direction</td>
</tr>
</tbody>
</table>

b. **Output Connection Point.** Create a Gateway block configuration (see Table 8).

<table>
<thead>
<tr>
<th>Table 8: Output Connection Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Point</td>
</tr>
<tr>
<td>Data Offset</td>
</tr>
<tr>
<td>Data Type</td>
</tr>
<tr>
<td>Block Size</td>
</tr>
<tr>
<td>Direction</td>
</tr>
</tbody>
</table>

4. **Data Mapping.** the connection points are now configured so that:

- Gateway_HMI:O >> PLC1:Block1
- Gateway_HMI:I << PLC1:Block2

5. **Testing.** Using the RSLogix5000 program, you can modify tags Gateway_HMI:O and verify they are written into Var1 and Var2, and verify changes made in the Gateway to tags Var3 and Var4 are updated in Gateway_HMI:I. Ensure the device is in the Run mode, otherwise the data transfer will be ignored by the Gateway.
Dimensions

16.57 in. (420.9 mm)
15.07 in. (382.8 mm)
4.52 in. (114.8 mm)
5.31 in. (134.9 mm)
8.71 in. (221.2 mm)
Technical Data

Electrical power ........................................... 24 Vdc, +/- 10%. 200 mA minimum without expansion card; 1 Amp maximum with expansion card fitted. Requires Class 2 or SELV rated power supply.

Communication ports
USB/PG Ports ............................................. Adheres to USB specification 1.1. Device only using Type B connection.
Serial Ports ................................................. Format and Baud rates for each port are individually software programmable up to 115,200 baud.
RS232/PG Port ............................................. RS232 port via RJ12.
COMM Ports ............................................... RS422/485 port via RJ45, and RS232 port via RJ12.
DH485 TXEN Port ........................................ Transmit enable; open collector, \(V_{OH}=15 \text{ Vdc}, V_{OL}=0.5 \text{ V @ 25 mA maximum.}
Ethernet Port ............................................ 10 BASE-T/100 BASE-TX, RJ45 jack is wired as a NIC (Network Interface Card).

LEDs ........................................................ STS: Status LED indicates condition of Gateway module.
TX/RX: Transmit/Receive LEDs show serial activity.
Ethernet: Link and activity LEDs.
CF: CompactFlash LED indicates card status and read/write activity.

Memory
On-board user memory ......................... 4 Mbytes of non-volatile Flash memory.
On-board SDRAM ........................................ 2 Mbytes
Memory card .............................................. CompactFlash Type II slot for Type I and Type II cards. Used for optional database storage only.

Real-time clock ........................................... Typical accuracy is less than 1 minute per month drift. Lithium coin cell battery; typical lifetime of 10 years at 25°C. This unit is not field serviceable. All work must be done by a qualified technician.

Environmental conditions
Operating temperature range .................. 0 to 50°C
Storage temperature range ...................... -30 to +70°C
Operating and storage humidity ............... 80% relative humidity, non-condensing, from 0 to 50°C
Vibration according to IEC 68-2-6 .............. Operational 5 to 150 Hz, in X, Y, Z direction for 1.5 hr, 2 g's
Shock according to IEC 68-2-27 ................. Operational 30 g, 11 msec in 3 directions
Altitude .................................................... Up to 2000 m

Construction ............................................. Carbon steel and stainless steel. Installation category 1, Pollution degree 2.

Power connection ...................................... Removable wire clamp screw terminal block. Wire gage capacity: 24 AWG to 12 AWG. Torque: 4.45-5.34 in-lb (0.5-0.6 N•m).
Mounting .................................................. Snaps onto standard DIN style top hat (T) profile mounting rails according to EN50022 -35 x 7.5 and -35 x 1.5.
Weight (Gateway control box only) .......... 15.1 oz (456.4 g)

All written and visual data contained in this document reflects the latest product information available at the time of publication.
Graco reserves the right to make changes at any time without notice.

Original instructions. This manual contains English. MM 312785
Graco Headquarters: Minneapolis
International Offices: Belgium, China, Japan, Korea
GRACO INC. AND SUBSIDIARIES • P.O. BOX 1441 • MINNEAPOLIS, MN 55440-1441 • USA
Copyright 2009, Graco Inc. All Graco manufacturing locations are registered to ISO 9001.
www.graco.com
Revision E, March 2023
California Proposition 65

CALIFORNIA RESIDENTS

Graco Standard Warranty

Graco warrants all equipment referenced in this document which is manufactured by Graco and bearing its name to be free from defects in material and workmanship on the date of sale to the original purchaser for use. With the exception of any special, extended, or limited warranty published by Graco, Graco will, for a period of twelve months from the date of sale, repair or replace any part of the equipment determined by Graco to be defective. This warranty applies only when the equipment is installed, operated and maintained in accordance with Graco’s written recommendations.

This warranty does not cover, and Graco shall not be liable for general wear and tear, or any malfunction, damage or wear caused by faulty installation, misapplication, abrasion, corrosion, inadequate or improper maintenance, negligence, accident, tampering, or substitution of non-Graco component parts. Nor shall Graco be liable for malfunction, damage or wear caused by the incompatibility of Graco equipment with structures, accessories, equipment or materials not supplied by Graco, or the improper design, manufacture, installation, operation or maintenance of structures, accessories, equipment or materials not supplied by Graco.

This warranty is conditioned upon the prepaid return of the equipment claimed to be defective to an authorized Graco distributor for verification of the claimed defect. If the claimed defect is verified, Graco will repair or replace free of charge any defective parts. The equipment will be returned to the original purchaser transportation prepaid. If inspection of the equipment does not disclose any defect in material or workmanship, repairs will be made at a reasonable charge, which charges may include the costs of parts, labor, and transportation.

THIS WARRANTY IS EXCLUSIVE, AND IS IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO WARRANTY OF MERCHANTABILITY OR WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE.

Graco’s sole obligation and buyer’s sole remedy for any breach of warranty shall be as set forth above. The buyer agrees that no other remedy (including, but not limited to, incidental or consequential damages for lost profits, lost sales, injury to person or property, or any other incidental or consequential loss) shall be available. Any action for breach of warranty must be brought within two (2) years of the date of sale.

GRACO MAKES NO WARRANTY, AND DISCLAIMS ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, IN CONNECTION WITH ACCESSORIES, EQUIPMENT, MATERIALS OR COMPONENTS SOLD BUT NOT MANUFACTURED BY GRACO. These items sold, but not manufactured by Graco (such as electric motors, switches, hose, etc.), are subject to the warranty, if any, of their manufacturer. Graco will provide purchaser with reasonable assistance in making any claim for breach of these warranties.

In no event will Graco be liable for indirect, incidental, special or consequential damages resulting from Graco supplying equipment hereunder, or the furnishing, performance, or use of any products or other goods sold hereto, whether due to a breach of contract, breach of warranty, the negligence of Graco, or otherwise.

FOR GRACO CANADA CUSTOMERS
The Parties acknowledge that they have required that the present document, as well as all documents, notices and legal proceedings entered into, given or instituted pursuant hereto or relating directly or indirectly hereto, be drawn up in English. Les parties reconnaissent avoir convenu que la rédaction du présent document sera en Anglais, ainsi que tous documents, avis et procédures judiciaires exécutés, donnés ou intentés, à la suite de ou en rapport, directement ou indirectement, avec les procédures concernées.

Graco Information

For the latest information about Graco products, visit www.graco.com.

TO PLACE AN ORDER, contact your Graco distributor or call to identify the nearest distributor.
Phone: 612-623-6921 or Toll Free: 1-800-328-0211 Fax: 612-378-3505